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Introducción 
 
El diseño en 3D es un mundo extraño para la mayoría de la gente, pero no es difícil empezar 
en este mundo. Esto es porque la mayoría de los programas de diseño en 3D, tales como 3D 
Max Estudio son muy difíciles de usar y cuestan mucho dinero.  
Sin embargo, hay algunos programas de diseño en 3d gratuitos como ZModeler. Con este 
maravilloso programas podemos hacer un montón de cosas diseñando objetos en tres 
dimensiones.  
 
ZModeler es un editor 3D independiente que crea objetos para juegos basados en la tecnología 
de Direct3D como GrandPrix 4. Por tanto nosotros podemos crear juegos para este bonito 
juego. Otra cosa importante es que ZModeler es un programa de diseño de pocos polígonos, 
por lo tanto podremos crear estupendos modelos en 3D con pocos polígonos. Además 
ZModeler nos permite exportar e importar objetos de otros programas de 3D como 3D studio 
Max o de Juegos como gp4.  
 
En este tutorial se intentan explicar los pasos esenciales para modificar un coche original de 
gp4, así vamos a poder ver que con poco trabajo el resultado es muy bueno. Primero deberías 
leer la guía del usuario de ZModeler para familiarizarte con el programa y la sección de 
ZModeler de este tutorial que explica la mayoría de las funciones de ZModeler.  
 
Finalmente, mi intención es hacer una guía que explique el proceso de modificar un coche.  
 

• Sacar el coche del Juego  
• Editarlo con ZModeler  
• Crear las nuevas texturas con Photoshop o the Gimp  
• Finalmente, devolver el coche y las texturas en el juego.  

 
Con un poco de práctica modelando en ZModeler estoy seguro que te vas a convertir en un 
gran diseñador en 3D. 
 
Cualquier sugerencia es buena para mejorar el tutorial.  
Espero que os guste el tutorial y que os puede ayudar en el diseño en 3D, además espero que 
os sea útil la traducción al castellano que me a costado su esfuerzo y tiempo ya que el tutorial 
es bastante extenso.  
vtemarticent AT hotmail DOT com  
 
Disfruta diseñando coches de Fórmula 1.  
 
------------------------------------------------------------------------------------------------  
Vicente Martí (Castellón, Spain) 
 
Vicente Martí home page ( http://www4.uji.es/~al063357 ) 
 
 
 

Copyright © 
No tienes permiso para reproducir ninguna parte de este tutorial ni usarlo como base de tu 

propio trabajo. 
Si quieres añadir un link al tutorial en tu website, por favor añade mi nombre en el link. 

 

Construye tu coche para GP4  Vicente Martí Centelles 

http://www4.uji.es/~al063357
http://www4.uji.es/~al063357


Construye tu coche para GP4     |      http://www4.uji.es/~al063357        |        Vicente Martí |        4 

Contenidos 
 
En este tutorial se intenta explicar los pasos esenciales para modificar un coche origial de gp4.  
Las partes del tutorial son:  

• ZModeler basics.  
o Introduction  
o Working with the views  
o Objects box  
o Status bar  
o The axis  
o The material editor  
o Modes  
o Snapping tools  
o Other important tools  
o Numeric Bar #1  
o Create  
o Modify  
o Surface  
o Select  
o Display  
o The gp4 filter  

• Como crear una buena malla 3D  
o ¿Que necesitamos?  
o Objetos en el cohe  
o Las fotos  
o Crear la malla 3D  
o Algunos consejos  

• Ajustar los vecotres normales  
o Qué es un vector normal?  
o Una superficie ligeramente doblada.  
o Una superficie muy doblada.  
o El alerón delantero de un coche de GP4  
o El cuerpo de un coche de GP4  

• Mapear el coche  
o Como mopear el coche  
o Guardar el car1 and car2 (lod_0)  
o El car_lod_4  
o Los materiales (texturas) en un coche de GP4  

• Pintar el choche  
o Como pintar la plantilla.  
o Texture shading  
o Linias del coche y tornillos  
o Logos  
o Pintar el cockpit  
o Pintar un casco  
o Pintar mecánicos e ingenieros  

• Finalmente instaler nuesto coche en gp4.  
o los archivos .gp4, the lod_0, lod_1, lod_2, lod_3 and lod_4  
o Los archivos .tex  
o Actualizar el cars.wad  
o Algunos ajustes con teameditor y Gp4Physics  

• Resumen: los pasos más imoortantes  
• Links y tutoriales  
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 Conceptos básicos de Zmodeler 
 

Introducción  

 
 
 
ZModeler tiene la pantalla dividida en 4 partes. Puedes seleccionar diversas vistas en cada una 
de estar partes: Delante, Detrás, Derecha, Izquierda, Arriba, Abajo, UVMapper, User view y 
vista 3D. 
Para cambiar la vista, haz click con el botón derecho en el botón que hay arriba a la izquierda 
en cada vista y selecciona la vista deseada de la lista que aparecerá. 
Puedes cambiar el tamaño de las vistas moviendo las barras de división. Hay una sola vista 
activa en cada instante (la que tiene en borde azul) y tu pueden hacer que se vea en toda la 
pantalla presionando "f" en el teclado. 
 
En ZModeler las mallas están hechas de caras (polígonos). Cada cara tiene tres vértices que 
están conectados por un lado. Los polígonos contiguos pueden compartir los vértices. Cada 
vértice tiene un vector normal (normal) asignado (un normal es la línea verde que puedes ver 
en el vértice, define como la luz es reflejada.)  
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Puedes hacer modificaciones en ZModeler en diferentes niveles: vértices, lados, caras y 

objetos. Puedes cambiar entre estos niveles haciendo click en la barra de 
herramientas o bien presionando 1, 2, 3 o 4 respectivamente en el teclado. 
 

Este botón es para crear y modificar splines. 
 

Estos botones son para abrir un nuevo documento en blanco, para cargar 
un archivo .z3d existente, para guardar el archivo que estamos editando y los dos últimos para 
importat y exportar un archivo respectivamente. 
 
Para hacer modificaciones a nivel de vértices, lados o caras tú tienes que estar dentro de un 
objeto. Para hacer esto primero pasa al nivel de objetos y haz click en el objeto que quieras 
editar. Después pasa al nivel de vértices, lados o caras para hacer las modificaciones. 
Si quieres hacer modificaciones a nivel de vértices, lados o caras en dos o más objetos, 
primero tienes que seleccionar estos objetos en el nivel de objetos, activar el modo SEL. 
Después de esto, pasar al nivel deseado (vértices, lados o caras) y hacer click en la selección. 
Finalmente ya puedes hacer las modificaciones en los objetos seleccionados (esto es muy útil 
para ajustar los normales, mapear...)  
 
Un objeto, cara, lado o vértice tiene 4 estados en ZModeler:  

• Activo: el objeto, cara, lado o vértice está en color azul brillante, el ratón esta encima 
de el. 
Inactivo: El ratón no está encima de el.  

• Escondido: no puedes ver el objeto, cara, lado o vértice. 
No Escondido: puedes ver el objeto, cara, lado o vértice.  

• Seleccionado: el objeto, cara, lado o vértice está de color rojo. Si pones el ratón sobre 
la selección está se convierte en activa de color rojo brillante. 
Deseleccionado: el objeto, cara, lado o vértice no está seleccionado.  

• Activado: puedes modificar el objeto (todos los objetos están activados por defecto). 
Desactivado: no puedes modificar el objeto, su color es gris (en la vista 3D el color es 
normal.)  

 
 
Trabajando con las vistas 
Tenemos 9 vistas en ZModeler y todas ellas son muy útiles. Puedes hacer modificaciones en 
una vista cada vez (en la vista activa), pero puedes ver las modificaciones en las otras vistas al 
mismo tiempo. 
Por ejemplo, puedes mover un vértice en la vista de frente y ver como se mueve en la vista 3D. 
 
Para cambiar la vista y configurar las opciones de cada vista (por ejemplo activar o desactivar 
la malla, activar el sombreado plano (flat shading) ...), haz click sobre el pequeño cuadrado que 
hay arriba a la izquierda en la vista deseada. Las opciones son auto-explicativas, por tanto 
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practica un poco con ellas.  
 
Veamos lo más importando sobre las vistas:  

• Frente, detrás, derecha, izquierda, arriba y abajo son muy obvias, ves el modelo de 
frente, detrás, derecha... 
Para hacer el zoom usa + y - en el teclado, para desplazar la vista usa las flechas del 
teclado.  

• Vista 3D: puedes ver tu modelo 3D en 3D con sombreado, reflexiones y las 
texturas.br> No puedes hacer ninguna modificación en esta vista. 
Para hacer zoom haz click con el botón derecho y arrastra, para rotas el modelo 3D 
haz click con el botón izquierdo y arrastra. Para desplazar la vista mantén presionados 
los dos botones de ratón y arrastra.  

• User view: es como la vista 3D pero se pueden hacer modificaciones al modelo 3D.  
Para hacer zoom, rotar y mover la vista hacer lo mismo que en la vista 3D pero 
manteniendo presionado el botón ALT del teclado al mismo tiempo que haces click con 
el ratón y arrastras.  

• UV Mapper: En está vista puedes ver una textura sobre la que vas a mapear 
superficies sobre ella. Para hacer zoom usa las teclas + y - de teclado, para mover la 
vista usa las flechas del teclado.  

 
 
Además puedes ver la vista activa en toda la pantalla presionando "f" en el teclado.  
 
Caja de objetos 
 

 
 
 
En esta caja están todos los objetos del archivo .z3d. Para hacer modificaciones a las 
propiedades de los objetos haz click con el botón derecho sobre el objeto deseado y un menú 
aparecerá. Las herramientas más importantes de este menú son: Order -> Move Up or Move 
Down, Create a Copy, Rename and Delete. (todas estas opciones son auto explicativas).  
Puedes esconder un objeto haciendo click sobre el en la lista y hacerlo visible haciendo otra 
vez click sobre el objeto en la lista. 
Los 4 botones de abajo són muy útiles: hide all (esconde todos los objetos), show all (muestra 
todos los objetos), select all (selecciona todos los objetos), deselect (desselecciona todos los 
objetos). 
 
 
Barra de estado 
En esta barra se muestra mucha información sobre la herramienta seleccionada. Esta 
información es muy útil, por tanto léela cuando selecciones una herramienta.  
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Por ejemplo en la siguiente imagen puedes ver la información que se muestra para la Scale 
tool:  

 
 
 
 
 

Los ejes 
La siguiente imagen representa los 3 ejes en ZModeler. El origen de los ejes es la X gris, esta 
X es el centro de los ejes y se puede desplazar a cualquier sitio.  

 
 
 
Puedes hacer modificaciones de dos formas diferentes: relativa y absoluta. Pedes cambiar de 
relativa a absoluta y viceversa presionando TAB en el teclado o haciendo click en la barra de 
herramientas.  

• Modificación relativa  
Es muy simple, se pueden hacer modificaciones en la vista que tú estás trabajando: H 
(horizontal), V (vertical), D (profundidad).  

o H: puedes hacer modificaciones en horizontal en la vista. (por ejemplo mover 
de la derecha a la izquierda en la vista pero no arriba y abajo.)  

o V: puedes hacer modificaciones en vertical en la vista . (por ejemplo mover de 
la en la vista arriba y abajo pero no derecha o a la izquierda.)  

o H + V: puedes hacer modificaciones verticalmente y horizontalmente en la 
vista.  

o D: se pueden hacer modificaciones en profundidad en la vista.  
o X: Es el centro del eje.  

Puedes poner el centro en cualquier lugar de la vista. Para ello poner el ratón 
en el lugar deseado y presionar " . " en el teclado o ir a Display -> Place Axis y 
hacer click en el sitio deseado con el ratón. 
Para borrar el centro de los ejes a su posición original (0, 0, 0), ir a Display -> 
Reset Axis. 
El centro de los ejes es un punto de referencia para un montón de 
herramientas como mirror, rotate, scale... Estás herramientas trabajan con 
respecto a este punto (el centro, X).  

 

• Modificación absoluta  
Es muy útil para la User View.  
Las modificaciones se hacen en X, Y o Z (no dos al mismo tiempo). Estos ejes son los 
ejes "globales" por defecto, pero se pueden cambiar (desplazar, rotar ...) usando las 
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herramientas Display ->Local Axis.  
Estos ejes son unos pequeños ejes que se pueden ver en cada objeto (cada objeto 
tiene un eje local (local axis)). El centro de estos ejes no es la X gris, sino que es el 
origen de estos pequeños ejes.  

 
 

El Material Editor  

Puedes acceder al material editor presionando en la barra de herramientas la bola roja o 
presionando "e" en el teclado. La siguiente imagen muestra como es el material editor:  

 

 
 

Por defecto hay un material: . Para añadir más materiales copia el y cambiarle el nombre.  

Si trabajas son archivos TGA para las imágenes deberías mantener los alpha parámetros 
unused para evitar problemas de transparencias.  

Finalmente, puedes cargar texturas para tus materiales, para hacer esto selecciona la cada de 
Primary Texture, entonces ves al botón de Load Map. El gestor de imágenes aparecerá, haz 
click sobre el botón Add... y busca tú imagen, finalmente haz click sobre el botón de OK. 
Para añadir una textura pera el Reflection Map haz lo mismo que para la Primary Texture pero 
selecciona la caja de Reflection Map.  

 
Algunos consejos sobre el material editor:  
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• Para mapear un grupo de caras, primero tienes que asignar un material a estas. Para 
hacer esto, selecciona un grupo de caras, activa el modo SEL, ves al material editor, 
selecciona un material (de la lista de los existentes materiales en la parte superior del 
material editor). Finalmente haz click sobre el botón Assign to Selection y el material 
seleccionado será asignado a tu selección de cara.  

• Puedes recargar todas las texturas presionando CTRL + R. Esto es muy útil cuando 
estás pintando el coche: guardar el archivo TGA en el programa de pintar (photosop, 
paint shop pro ...), ir a ZModeler y presionar CTRL + R y vas a ver las modificaciones 
sobre tu coche en la vista 3D.  

 
 
 
 
 
Modos 

Hay diferentes modos en ZModeler: EXT (extendido), SEL (seleccionado) and MUL (multiple).  

Veamos una explicación sobre estos modos: 

• Modo EXTendido Trabaja con herramientas como move, rotate, scale… Cuando 
seleccionas el modo EXT en la barra de menú (o cuando presionas " , " en el teclado), 
aparecen dos círculos al cursor. El círculo pequeño modificará los elementos como una 
modificación normal, pero el círculo grande modificará menos los elementos: el 
elemento más cercano al círculo grande menos se modificará. 
Además, presionando las flechas de arriba y abajo en el teclado se hace grande o 
pequeño el círculo de fuera (grande). Presionando las flechas de derecha e izquierda 
en el teclado se hace grande o pequeño el circulo de de dentro (pequeño).  

• Modo SELeccionado fuerza a ZModeler a trabajar con elementos seleccionados, es 
decir, tu tienes que seleccionar elementos: objetos, caras, lados o vértices, y cuando 
apliques alguna modificación se va a aplicar sobre todos los elementos seleccionados. 
Puedes activar el modo SEL presionando el botón SEL en la barra de menú o presionar 
la barra espaciadora en el teclado. 

• Modo MULtiple trabaja con algunas herramientas como move, rotate, select... Por 
ejemplo, si quieres mover o seleccionar dos vértices que están próximos en la vista, 
activa el modo MUL presionando el botón en la barra de menú o presionado la tecla " / 
" en el teclado y selecciona la herramienta deseada: move, select... Después de esto, 
pon el ratón sobre tos dos vértices que están próximos y verás que los dos vertices se 
vuelven activos (color azul brillante), finalmente cuando hagas click y arrastres los dos 
vértices se moverán (si has seleccionado la herramienta move) o los dos vértices serán 
seleccionados (si has seleccionado la herramienta select).  

 
 
Herramientas de Snapping 

Snapping es cuando mueves algo (un objeto, vértice, cara…) con el ratón y entonces es 
automáticamente magnéticamente atraído hacia una spline, vértice, lado o parrilla.  
 
Veamos todas las opciones (se pueden seleccionar diversas opciones al mismo tiempo, por 
ejemplo seleccionar las herramientas vertex and grid line snapping):  

• Spline Snapping tool. 
Cuando arrastras algo con el ratón, solapa con la el vértice de la spline más próxima.  
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• Vertex Snapping tool. 
Cuando arrastras algo con el ratón, solapa con la el vértice más próximo.  

• Edge Snapping tool. 
Cuando arrastras algo con el ratón, solapa con la el lado más próximo.  

• Grid Snapping tool. 
Cuando arrastras algo con el ratón, solapa con la linea de la parrilla de la vista más 
próxima.  

• 2D / 3D Snapping toggle switch. 
Si presionas este botón vas a activar el modo 3D. En el modo 3D cuando arrastras algo 
con el ratón se solapa con el más próximo spline vértice, vértice o lado (dependiendo 
de la herramienta de snapping seleccionada) en las 3 dimensiones. 
Por ejemplo, si tú arrastras un vértice con la vertex snapping tool y el 3D mode, el 
vértice solapará con el vertice más proximo en las tres dimensiones, pero si tienes 
activado el 2D mode, solo solapará en 2 dimensiones (las dimensiones de la vista 
actual).  

• No Depht (sin profundidad) Snapping mode toggle. 
Si no presionas este botón, cuando algo solape en ZModeler se van a considerar 3 
dimensiones en el vértice, lado... que tu estás moviendo y el vértice, lado ... que 
quieres que solape sobre.  
Si presionas este botón ZModeler solo va a tener en cuenta 2 dimensiones (las 
dimensiones de la vista actual en la que estás moviendo el vértice, lado...), es decir, la 
profundidad no es considerada.  

También se puede usar por ejemplo el vertex-snapping tool en la User View. En este caso 
cuando arrastres un vértice con la herramienta vertex-snapping activada, el vértice que estés 
moviendo va a solapar con el otro vértice en las 3 dimensiones. Esto es muy útil para crear un 
contorno a dos superficies planas con doble vértices (ver la sección de malla 3D).  
 
Otras herrmientas importantes 

• Selecting tools. 
Estos botones nos permiten seleccionar algo con el botón izquierdo del ratón en lugar 
del botón derecho usando los comandos Select -> ...  

• Zoom tool. 
Presionar ALT y hacer click con el botón izquierdo para agrandar y con el botón 
derecho para hacer pequeño. Mantener presionado ALT, hacer click con el botón 
izquierdo del ratón y arrastrar, el rectángulo que hagas será agrandado a toda la vista. 
Además puedes usar las teclas + y - del teclado para hacer zoom.  

• Panning tool. 
Mantener presionado ALT, hacer click y arrastrar para mover la vista. También puedes 
usar las flechas del teclado para mover la vista.  

• Fit to view tool. 
Presiona este botón, mantén presionado ALT y haz click sobre un objeto para hacer 
que este objeto ocupe toda la vista, o hacer click con el botón derecho para que toda tú 
selección ocupe toda la vista.  
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• Auto Scroller tool. 
Presiona este botón y mueve el ratón por la vista para que está se mueva con el ratón.  

• Background image control tool. 
Este botón tiene varias funciones: haciendo click con el botón izquierdo del ratón y 
arrastrando se mueve la imagen del fondo (background image) y haciendo click con el 
botón derecho y arrastrando se hace zoom en la imagen del fondo.  

• Predefined create objects tools. 
Estas herramientas permiten crear estos objetos 3D: cubo, esfera, cilindro, cono, toro y 
tubo. Selecciona el objeto deseado, haz click con el botón izquierdo y arrastra, tu objeto 
3D será creado.  

 
 
Numeric Bar #1 
 

 
 
 
Esta barra numérica es un input numérico para diversas herramientas:  

• Modify -> Rotate: 
Puedes ajustar cuantos grados vas a rotar.  

• Modify -> Scale: 
Puedes ajustar el % que quieres que se reduzca o engrandezca tu objeto, lado...  

• Modify ->Break: 
Puedes ajustar el número de vértices que quieres insertar cuando "rompas" (break) un 
lado.  

• Surfaces -> Normals ->Rotation 
Se puede ajustar cuantos grados se van a rotar los normales.  

• Surfaces -> Normals ->Projection 
Se puede ajustar el % de proyección que se va aplicar.  

• Create -> Splines -> NGon 
Se pude ajustar el nº de lados de la ngon.  

 
 
Create 
 
 
Primero de todo se tiene que crear un objeto porque no se puede crear una sola cara sin que 
esta pertenezca a un objeto. (Lo más fácil es crear una superficie plana.) Además, ninguna de 
las herramientas de creación dependen de los ejes y todas ellas trabajan con click con el botón 
izquierdo.  
Las más interesantes son:  

• Create -> Surfaces 
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o Create -> Surfaces -> Flat 
Para crear un nuevo objeto con una superficie plana: selecciona esta 
herramienta, haz click con el botón izquierdo y arrastra para crear un 
rectángulo. Escribe el nº de pasos horizontales y verticales y el nombre del 
nuevo objeto en la caja de diálogo que aparecerá.  

 

• Create -> Objects 
o Create -> Objects -> Copy 

Puedes copiar objetos con esta herramienta. Se puede copiar un solo objeto o 
varios objetos seleccionados. El resultado es un solo objeto.  
Para copiar objetos: selecciona esta herramienta, pasa al nivel de objetos, haz 
click con el botón izquierdo en el objeto o los objetos seleccionados que 
quieres copiar, escribe el nombre del nuevo objeto que será creado en la caja 
de dialogo que aparecerá.  

o Create -> Objects -> Detach 
Se puede crear un nuevo objeto a partir de una polígono o varios polígonos 
seleccionados. 
Para crear el nuevo objeto selecciona esta herramienta y haz click con el botón 
izquierdo sobre los polígonos seleccionados, finalmente escribe el nombre del 
nuevo objeto (solo funciona en el nivel de polígonos).  

o Create -> Objects -> Unite Select 
Esta herramienta nos permite unir objetos y vértices. 
Para unir objetos, en el nivel de objetos selecciona los objetos que quieres unir 
en un solo objeto, selecciona la herramienta Unite Select y haz click con el 
botón izquierdo. Finalmente escribe el nombre del nuevo objeto en la caja de 
dialogo. 
Para unir vértices, pasa al nivel de vértices, selecciona dos no más vértices y 
haz lo mismo que para unir objetos. El resultado es un vértice. Si mantienes 
presionado CTRL los vértices se mueven en el mismo punto pero no se unen 
en un solo vértice.  

o Create -> Objects -> By Material -> Split 
Esta herramienta se usa en objetos seleccionados para dividirlos por su 
material en múltiples subobjetos.  

 

• Create -> Faces 
Esta herramientas funciona en el nivel de vértices. Debes añadir los polígonos a un 
objeto existente (no puede existir un polígono que no pertenezca a un objeto).  

o Create -> Faces -> Single  
Esta herramienta crea un solo polígono. Se puede usar un vértice existente 
(poner el ratón encima del vértice y el vértice se va a convertir de color azul, 
entones haz click con el botón izquierdo) o puedes crear un nuevo vértice (para 
crear nuevos vértices no hagas click sobre un vértice). 
Hay que recordar que cada polígono tiene 3 vértices como habíamos dicho 
anteriormente.  

o Create -> Faces -> Strip  
Esta herramienta crea un cinta de polígonos. Se puede usar un vértice 
existente o crear uno de nuevo. 
Para crear una cinta: selecciona esta herramienta, click con el botón izquierdo 
para crear el primer vértice y continuar haciendo clicks para crear los otros 
vértices. Los últimos dos vértices del polígono anterior son los dos primeros del 
nuevo polígono y así continuamente. Para parar de crear polígonos, mantén 
presionado CTRL y haz click con el botón izquierdo.  

o Create -> Faces -> Fan  
Está herramienta crea un abanico de polígonos. El primer click con el botón 
izquierdo crea el vértice del centro del abanico. Los otros clicks crean los 
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vértices (y por tanto los polígonos) del abanico con respecto al vértice del 
centro. Para parar, mantener presionado CTRL y hacer click con el botón 
izquierdo del ratón.  

 

• Create -> Spline 
Se pueden crear splines con estas herramientas.  

 
 
Modify 
Estas herramientas nos permiten hacer un montón de modificaciones. Todas ellas funcionan 
con el botón izquierdo del ratón.  

• Modify -> Extended 
o Modify -> Extended -> Perspective 

Haz click y arrastra el ratón arriba y abajo para cambiar el factor de 
perspectiva.  

o Modify -> Extended -> Bend 
Haz click con el botón derecho para ayuda detallada. Haz click y arrastra el 
ratón arriba y abajo para doblar la geometría (esta herramienta depende del 
centro de los ejes, X).  

 

• Modify -> Align 
o Modify -> Align -> Axis 

Selecciona un grupo de vértices, activa el modo SEL y haz click con el botón 
izquierdo, los vertices seleccionados serán alineados al mismo valor en el eje 
deseado (H, V, D o X, Y, Z).  

o Modify -> Align -> Line 
Selecciona un grupo de vértices, activa el modo SEL y haz click con el botón 
izquierdo para crear una línea basada en vértices. Finalmente mantén 
presionado CTRL y haz click para alinear los vértices seleccionados a la línea.  

o Modify -> Align -> Plane 
Selecciona un grupo de vértices, activa el modo SEL y haz click con el botón 
izquierdo para crear un plano basada en vértices. Finalmente mantén 
presionado CTRL y haz click para alinear los vértices seleccionados al plano.  

o Modify -> Align -> View 
Selecciona un grupo de vértices, activa el modo SEL y haz click con el botón 
izquierdo, los vértices seleccionados serán alineados al plano de la vista.  

 

• Modify -> Move 
Se pueden mover uno o varios seleccionados (en el modo SEL) vértices, lados, objetos 
y splines a lo largo de los ejes seleccionados (H, V, D or X, Y, Z).  

• Modify -> Rotate 
Se puede rotar uno o varios seleccionados: vértices, lados, objetos y splines con 
respecto el centro del eje (X).  
Para rotar un nº especifico de grados poner este nº en la numeric box #1. Esta 
herramienta depende de los ejes (H, V, D o X, Y, Z).  

• Modify -> Scale 
Se pueden scalar vertices, lados y objetos. Esta herramienta depende de los ejes (H, 
V, D or X, Y, Z) y del centro del eje (X). El elemento o los elementos son escalados con 
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respecto al centro del eje y según el modo de eje (H, V, D or X, Y, Z).  
Se puede especificar el % que se quiero reducir o agrandar el elemento en la numeric 
box #1.  
Para escalar en 3D, mantener presionado SHIFT.  

• Modify -> Mirror 
Esta herramienta modifica la posición de vértices, lados y objetos, la modificación se 
realiza con respecto al centro de los ejes (X) y del modo de ejes (H, V, D or X, Y, Z), se 
crea una imagen especular.  
Después de crear una imagen especular de un objeto debes reorientarlo porque 
después de crear la imagen especular el objeto tiene las partes de dentro fuera. 
Tambien tienes que cambiar de dirección (flip) los normales.  

• Modify -> Break 
Se puede romper un vértice o varios vértices seleccionados (esta herramienta funciona 
con el modo SEL y el MUL). Cuando rompes un vértice, se crean nuevos vértices (uno 
por cada polígono). 
 
Se puede romper un lado (no funciona con el modo SEL, EXT y MUL) y un nuevo 
vértice es creado en el centro del lado, por tanto dos nuevos polígonos son creados (se 
pueden añadir más vértices usando la numeric box #1).  
 
Se puede romper un polígono (cara) o varios polígonos seleccionados (esta 
herramienta funciona con el modo SEL y el MUL). Un nuevo vértice es creado en el 
centro del polígono y por tanto tres nuevas caras son creadas.  

• Modify -> Reorient 
Se pueden reorientar lados, caras y objetos. Esta herramienta da la vuelta a las caras 
de dentro a fuera en el nivel de polígonos y de objetos. En el nivel de lados, esta 
herramienta cambia la dirección del lado a los otros dos vértices (solo se puede aplicar 
esta herramienta a un lado a la vez). 
Si se mantiene presionado CTRL mientras se hace click se cambia la dirección (flip) de 
los normales.  

• Modify -> Delete 
Se pueden borrar vértices, lados, polígonos, objetos y sp lines. Cuando se borra albo 
en un objeto, ZModeler borra los vértices que no son usados que están conectados con 
el vértice que has borrado. Si no quieres borrar los vértices no usados mantén 
presionado CTRL mientras haces click.  

 
 
Surface 
Con estas herramientas se puede mapear nuestro modelo 3D y modificar los normales. Todas 
estas herramientas funcionan con el botón izquierdo del ratón.  

• Surface -> Mapping 
Se pueden hacer algunas modificaciones al UV mapping de nuestro modelo 3D. 
Recuerda asignar un material a los polígonos antes de asignar el UV mapping.  

o Surface -> Mapping -> Assign UV 
Esta herramienta asigna el mapping al modelo 3D. Depende de la vista (left, 
top, front…) en la que hayas hecho click sobre los polígonos seleccionados. 
Si la cara o las caras seleccionados ya están mapeadas, cuando apliques esta 
herramienta en la vista UV verás el mapping de esar caras, quiero decer que 
los polígonos no son remapeados si aplicas por segunda vezla herramiento de 
Assign UV.  

o Surface -> Mapping -> Reset UV 
Esta herramiento borra el UV mapping de los poligonos seleccionados. Estp es 
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útil cuando se quiere remapear un grupo de poligonos: seleccionar los 
poligonos deseados, borrar el UV mappingo de estos poligonos y assiagnar un 
nuevo UV mapping.  

o Surface -> Mapping -> Flip UV 
Esta herramienta voltea (flip) el UV mapping.  

o Surface -> Mapping -> Rotate UV 
Esta herramienta rota el UV mapping.  

 

• Surface -> Normals 
Se pueden hacer un montón de ajustes a los normales de nuestro modelo. Recordar 
que para ver el efecto de los normales en nuestro coche tenemos que desactivar el flat 
shading y para ver los reflejos (environment mapping) tenemos que cargar un mapa de 
reflexión para cada textura en el material editor. 
 
En este tutorial se trabaja con los normales en la sección de Normales, donde se 
explican los pasos a seguir para conseguir un buen sombreado y unos buenos reflejos 
en nuestro coche. 
Además una buena explicación de las herramientas para ajustar los normales se puede 
encontrar en el tutorial de ZModeler: Creating cars from scratch.  

o Surface -> Normals -> Bound Gismo 
Haz click con el botón derecho para obtener información detallada sobre esta 
herramienta en ZModeler.  

o Surface -> Normals -> Rotate 
Rota los normales.  

o Surface -> Normals -> Scaeling 
Cambia la longitud de los normales. Cuando el normal es más corto refleja 
menos luz.  

o Surface -> Normals -> Flip 
Esta herramienta voleta (flip) la dirección del normal, mantener presionado 
CTRL para hacerlo en 3D.  

o Surface -> Normals -> Calculate 
Esta herramienta calcula los normales (vectores que definen como la luz es 
reflejada en la superfice).  

o Surface -> Normals -> Projection 
Esta herramienta proyecta los normales desde el centro del eje (X). Se puede 
ajustar el % de proyección que será aplicado a los normales actuales usando la 
numeric bar #1.  
Si mantienes presionado CTRL la proyección es paralela, y si mantienes 
presionado SHIFT la proyección es en 3D.  

o Surface -> Normals -> By Gismo 
Esta herramienta proyecta los normales pero el centro de la proyección es el 
vértice más proximo de un objeto (el gismo object).  

 
 
Select 
Recuerda que con algunas herramientas como move, scale... para trabajar con elementos 
seleccionados deboes pasar al modo SEL que nos permite trabajar con estos elementos 
seleccionados.  
Se pueden seleccionar objetos, caras, lados y vértices. Todas las herramientas de selección 
funcionan con el botón derecho del ratón.  

• Select -> Single 
Se pueden seleccionar polígonos, lados, vértices y objetos uno a uno con un click con 
el botón derecho del ratón. Para deseleccionar un elemento seleccionado haz click con 
el botón derecho del ratón sobre dicho elemento y será deseleccionado.  
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• Select -> Quadr 
Para seleccionar varios elementos o uno solo con esta herramienta, click con el botón 
derecho del ratón y arrastrar, un rectángulo va a aparecer. 
Para extender la selección mantén presionado SHIFT y selecciona un nuevo grupo de 
elementos. Para deseleccionar una parte de tu selección mantén presionado CTRL, 
haz click con el botón derecho del ratón y arrastra para deseleccionar elementos.  

• Select -> Circle 
Lo mismo que para QUADR pero la forma es una elipse.  

• Select -> Separated 
Esta herramienta solo funciona en el nivel de caras y de vértices (faces and vertex 
level). 
En el nivel de vértices esta herramienta selecciona el vértice sobre el cual el ratón está 
encima y todos los vértices que están conectados a este por un vértice.  
En el nivel de caras (polígonos), esta herramienta selecciona todas las caras 
conectadas por un lado a la cara sobre la que esta el ratón. 
Para deseleccionar mantén presionado CTRL.  

• Select -> All 
Selecciona todos los objetos en el nivel de objetos, todos las caras en el nivel de caras, 
y todos los vértices en el nivel de vértices.  
Esta herramienta selecciona solo los elementos visibles.  

• Select -> None 
Deselecciona todos los objetos en el nivel de objetos, todos las caras en el nivel de 
caras, y todos los vértices en el nivel de vértices.  

• Select -> Invert 
Invierte la selección actual. Todo lo que esta deseleccionado se convierte en 
seleccionado y todo lo seleccionado se convierte en seleccionado.  

• Select -> By material 
Esta herramienta selecciona las caras (polígonos) que pertenecen a un cierto material 
(se puede seleccionar este material en la caja de dialogo que aparece después de 
hacer click con el botón derecho). 
Esta herramienta no borra la selección existente antes de usarla, simplemente añade 
las caras del material seleccionado a la selección anterior. 
Para deseleccionar mantén presionado CTRL.  

 
 
NOTE: Se pueden seleccionar herramientas que funcionan con el botón derecho del ratón 
(herramientas de selección) y herramientas que funcionan con el botón izquierdo del ratón al 
mismo tiempo.  
Por ejemplo se puede seleccionar al mismo tiempo Select -> Single y Create -> Objects -> 
Unite Select. Con un click con el botón derecho se pueden seleccionar objetos y con un click 
con el botón izquierdo se puede unir la selección.  
 

•  Display -> Reset Axis 
Esta herramienta desplaza el centro de los ejes (X) al origen, (0, 0, 0). Además esta 
herramienta no desactiva otra herramienta que funcione con el botón derecho o izquierdo del 
ratón que tubieramos seleccionada antes de seleccionar esta herramienta.  
•  Display -> Center Axis 
Centra el eje local (X, Y, Z axis) del objeto.  
•  Display -> Local Axis 

• Display -> Local Axis -> Copy 
Haz click en el objeto del cual quieres copiar el eje local, después haz click sobre el 
objeto al que le quieres copiar el eje local.  

• Display -> Local Axis -> Move 
Esta herramienta mueve el eje local del objeto. Haz click en el objeto y arrastra para 
mover el eje.  
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• Display -> Local Axis -> Rotate 
Esta herramienta rota el eje local del objeto. Haz click en el objeto y arrastra para rotar 
el eje.  

• Display -> Local Axis -> Flip 
Cambia de dirección 180º el eje local. Solo se puede aplicar en el modo X, Y o Z.  

• Display -> Local Axis -> Reset 
Borra la posición y la orientación del eje local.  

 
 
El filtro de grand prix 4 
 
Se pueden importar archivos .gp4 con este filtro pero el archivo debe estar desprotegido. Si 
esta protegido no hay ningún problema, simplemente abre el archivo protegido con 3D editor o 
el GP4 genius y guárdalo sin hacer ninguna modificación. Ahora ya puedes importar el archivo 
desprotegido en ZModeler. 
Además se pueden exportar archivos .gp4 que por defecto estan protegidos. Si quieres 
exportar un archivo .gp4 que no este protegido, escribe la extensión en letras mayúsculas en la 
caja de dialogo de exportar. Por ejemplo: car_minardi_car1_lod_0.GP4  
Por tanto como no podemos importar archivos .gp4 que por defecto están protegidos, debemos 
trabajar en archivos .z3d para trabajar más cómodamente con nuestro modelo 3D.  
En otro lugar, GP4 es muy sensible al nombre de los objetos: los nombres dependen de si 
están escritos en mayúsculas y minúsculas (debes escribirlos en minúsculas) y otra cosa muy 
importante es que los nombres deben estar en orden.  
El filtro de GP4 no soporta polígonos sin textura (es decir que no estén mapeados), por tanto 
debes mapear todos los polígonos y cargar las texturas en el material editor antes de exportar. 
Hay que recalcar que es muy importante cargar las texturas en el material editor antes de 
exportar, de forma que en la vista 3D veamos el coche con las texturas, ya que si las texturas 
no están cargadas el mapeado del coche (o el de cualquier modelo 3D) no es exportado 
correctamente en formato .gp4.  
 
 

Teclas de acceso rápido en ZModeler (ZModeler 
hotkeys): 

Las teclas de acceso rápido en ZModeler son muy útiles para acelerar la edición. Para 
configurar estas teclas leer la explicación que hay más abajo después de la tabla. Además 
debes comprobar que el botón ACTIVE y el Enabled estén activados para cada herramienta 
que tenga una tecla de acceso rápido.  
Además hay una importante restricción en las teclas de acceso rápido: 
Las teclas de acceso rápido solo se pueden usan en las vistas que no sean la 3D y que el 
cursor está dentro de la vista.  

Teclas de archivos 
Ctrl + N Borra la escena y crea una de nueva 
Ctrl + O Abre una escena y borra la escena actual 
Ctrl + S Guarda la escena 
Ctrl + I Importa archivos 3D y los fusiona con la escena actual 
Ctrl + E Exporta la escena actual 
Alt + X Salir del programa 
Opciones de presentación y vista 
Q Flat shading (sombrado plano) 
A High chrome (alta reflexión) 
B Chrome (reflexión) 
S Solid (solido) 
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W Wire frame (malla) 
Ctrl + T usar texturas 
Ctrl + R Recargar todas las texturas 
P Cámara con perspectiva 
Alt + R Borrar las opciones de la cámara 
Shift + R Borrar la posición de la cámara 
G Mini Parrila 
Alt + G Parrilla Normal 
I Cargar la imagen de fondo 
Alt + I Mostrar la imagen de fondo 
F6, Shift + F6 Pasar la vista activa 
Arrow keys Mover la vista activa 
+, - Zoom 
Ctrl + Shift Crea un objeto de prueba (letra Z) 
Selección 
Shift + G Select quadr (selecciona la herramienta) 
Shift + A Select All (actúa) 
Shift + I Select Invert (actúa) 
Shift + S Select Single (selecciona la herramienta) 
Shift + D Select None (actúa) 
Normales 
C Surface/Normals/Calculate (actúa) 
Ejes y modos 
TAB, Shift TAB Cambia el eje (H, V, D or X, Y, Z) 
“ . ” Pone el centro del eje al cursor del ratón 
Barra espaciadora Pasa del modo SEL activado o desactivado 
“, “ Pasa del modo EXT activado o desactivado 
“ / “ Pasa del modo MUL activado o desactivado 
1 Pasa al nivel de vértices 
2 Pasa al nivel de lados 
3 Pasa al nivel de caras 
4 Pasa al nivel de objetos 
“ ´ ” Pasa al nivel de splines 
CTRL + Flechas Salta de vértice a vértice o de cara a cara 
Borrar Temporary switches to objects level for selecting another object for 

modifications. 
Enter Alternate to pressing the left mouse button 
Aceleradores de edición 
Supr (Del) Modify/Delete (actúa) 
Insert (Inst) Modify/Break (actúa) 
R Modify/Reorient (actúa) 
Alt + M Modify/Move (selecciona la herramienta) 
U Create/Objects/Unite Select (actúa) 
Alt + S Create/Faces/Strip (selecciona la herramienta) 
Alt + F Create/Objects/Flat (selecciona la herramienta) 
H Display/Hide (actúa) 
Alt + A Display/Unhide (actúa) 
Barras de herramientas y cajas de dialogo 
Ctrl + 1 Mostrar - esconder la barra de objetos 
F1 Sobre ZModeler 
Ctrl + A Caja de atributos 
E Material editor 
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Además podemos añadir algunas nuevas teclas de acceso rápido para ZModeler. Para hacer 
esto ir a Plugins -> Hot Keys:  

 
 
 
Entonces una caja de diálogo aparecerá:  

 
 
 
Finalmente selecciona la herramienta deseada y ves a la sección de Hot Keys (abajo a la 
derecha) y selecciona Enabled.  
Después selección la tecla de acceso rápido (Custom1 + Custom 2 + Key).  
 
Por ejemplo yo he añadido para la herramienta Create -> Faces ->Single la techa de acceso 
rápido Alt + Z (notar que por defecto esta herramienta no tiene asignada ninguna tecla de 
acceso rápido) 
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La malla 3D 
 
Que necesitamos para hacer el coche?  
 
Necesitamos algunas fotos del coche y un coche original de GP4 (el lod_0 y el lod_4). 
Estas son algunas fotos del R23 (Voy a explicar como crear el alerón delantero):  

 
Vista desde arriba  

Vista desde la derecha  
Vista desde frente  

 

Para importar el coche original de gp4, primero necesitas extráelo del cars.wad. Para hacer 
esto vamos a usar gp4-master(Lo puedes descargar en www.grandprixgames.org) o 
WadUpdater (Lo puedes descargar en www.realgpx.com). 
Una breve explicación de que es un archivo .wad es que este tipo de archivos es similar a un 
archivo comprimido .zip que contiene muchos archivos, con esto se gana tiempo a la hora de 
cargar el juego en la memoria del ordenador, por eso se usa este tipo de archivos comprimidos 
.wad en gp4. Es decir es como si estuviéramos comprimiendo y descomprimiendo.  

Veamos como extraer el coche del cars.wad usando WadUpdater: 

 

 
 
Selecciona tu cars.wad en WadUpdater, entonces haz click en el botón ExtractWad. Escribe el 
nombre de la carpeta en la cual los archivos de tu cars.wad serán extraidos (por ejemplo: cars) 
y haz click en OK.  
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Todos los archivos de tu cars.wad serán extraídos en esta carpeta.  
Ahora tienes que buscar los archivos .gp4 que necesitamos para modificar 
(car_myteam_car1_lod_0.gp4 y car_myteam_car1_lod_4.gp4).  

Una vez tengamos el cohce fuera del wad, abre ZModeler y importa el archivo .gp4 (el archivo 
car_myteam_car1_lod_0.gp4), guarda como car1.z3d (Este es el archivo que vamos a 
modificar). 
A continuación importa el archivo .gp4 (el archivo car_myteam_car1_lod_4.gp4), guarda como 
car_lod_4.z3d. 
 
Recureda que si el archivo .gp4 esta protegido y no lo puedes importar en ZModeler, abre el 
archivo .gp4 con GP4 genius (descargar en www.grandprixgames.org) o 3Deditor (se puede 
descargar en www.realgpx.com), entonces salva el archivo y ya estará desprotegido. A 
continuación importa el archivo .gp4 en ZModeler. 

Vamos a modificar algunas partes del coche original de gp4 porque es muy difícil construir uno 
desde 0.  

 

 

Objetos en un coche de gp4  
 
Deberías saber que todos los coches en GP4 tienen las ruedas en la misma posición, por tanto 
no vamos a poder modificar la posición original de las suspensiones ni de los discos de freno 
porque si los movemos las ruedas no van a esar en la posición correcta (ya que estarán en la 
posición original).  
Nosotros podemos modificar el cockpit porque si que podemos ajustar la posición del casco y 
del volante para cada coche con el TeamEditor (esta explicado en la sección de este tutorial De 
ZM a GP4).  
Además podemos modificar las posiciones de todos los otros objetos del coche.  
 
El orden de los objetos en un coche de gp4 es muy importante, y el orden es el siguiente: 
 
objetos en car_myteam_car1_lod_0.gp4  

1. cockpit  
2. engine  
3. f_l_brakeglow  
4. f_r_brakeglow  
5. left_barge_board  
6. left_front_fin  
7. left_front_suspension  
8. left_front_wing  
9. left_rear_fin  
10. left_rear_suspension  
11. left_sidepod  
12. lower_rear_wing  
13. nose_cone  
14. r_l_brakeglow  
15. r_r_brakeglow  
16. rear_light_on  
17. right_barge_board  
18. right_front_fin  
19. right_front_suspension  
20. right_front_wing  
21. right_rear_fin  
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22. right_rear_suspension  
23. right_sidepod  
24. upper_rear_wing  
25. z_cockpit_insert  
26. z_cockpit_left_mirror  
27. z_cockpit_right_mirror  
28. z_cockpit_visor  

 
Un coche de gp4 tiene 5 lods (los puedes ver en els cars.wad). Estos lods son:  

• car_myteam_car1_lod_0.gp4  
• car_myteam_car1_lod_1.gp4  
• car_myteam_car1_lod_2.gp4  
• car_myteam_car1_lod_3.gp4  
• car_myteam_car1_lod_4.gp4  

 
El lod_0 es la shape más detallada y se usa cuando tu ves el coche a una distancia corta. Y el 
lod_4 es la shape menos detallada que se pude ver en los espejos retrovisores o cuando el 
coche esta muy lejos. 
Los objetos en los otros lods son:  
 
Objetos en: car_myteam_car1_lod_1.gp4 
car_myteam_car1_lod_2.gp4 
car_myteam_car1_lod_3.gp4 

1. cockpit  
2. engine  
3. f_l_brakeglow  
4. f_r_brakeglow  
5. left_barge_board  
6. left_front_fin  
7. left_front_suspension  
8. left_front_wing  
9. left_rear_fin  
10. left_rear_suspension  
11. left_sidepod  
12. lower_rear_wing  
13. nose_cone  
14. r_l_brakeglow  
15. r_r_brakeglow  
16. rear_light_on  
17. right_barge_board  
18. right_front_fin  
19. right_front_suspension  
20. right_front_wing  
21. right_rear_fin  
22. right_rear_suspension  
23. right_sidepod  
24. upper_rear_wing  

 
objetos en car_myteam_car1_lod_4.gp4  

1. cockpit_low  

Nosotros vamos a editar el lod_0 y cuando este acabado, vamos a borrar los z-
objects(z_cockpit_insert, z_cockpit_left_mirror,z_cockpit_right_mirror, z_cockpit_visor) y lo 
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vamos a salvar como lod_1, lod_2 and lod_3. 
Finalmente no vamos a editar el lod_4, solamente lo vamos a remapear (básicamente para ver 
los colores correctos de nuestro cohce en los espejos retrovisores).  
 
 
Para acabar esta sección, os voy a contar un buen truco para ahorrar tiempo y trabajo a la hora 
de ordenar los objetos del coche.  
Para ordenar los objetos de forma fácil: 
 
Escribe los nombres de todos los objetos en ZModeler (todos los objetos, pero no en orden 
alfabético). 
 
Ahora exporta el coche en formato .gp4. 
 
Abre el coche exportado con 3Deditor ( www.realgpx.com). 
Ves a Action -> Sort car objects y los objetos del cohce serán ordenados alfabéticamente de 
forma automática). 

 
 
Guarda este archivo. 
 
Finalmente importa el archivo guardado en ZModeler y vas a comprobar que los objetos están 
en orden alfabético. Para acabar guarda el archivo importado en formato .z3d para después 
volver a exportar el lod_0, ... ,lod_3. 
 
 
 
Gracias a Dahie por contarme este truco. 
 
Las Fotos  
 
Necesitamos algunas fotos de las partes del coche que vamos a modificar, por ejemplo el 
alerón delantero. 
A continuación se muestran algunas fotos del alerón delantero del R23 que se va a modificar: 
 
Se necesita una foto de la vista superior, otra del lado y otra desde frente. 
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Arriba  

Derecha  Frente  

 
Las fotos las debes guardar en formato BMP, TGA o PNG para poderlas importar en ZModeler. 
Si quieres puedes salvarlas en formato JPG, pero para poderlas importar en ZModler deberás 
instalar los plugins para ZModeler de: ZModeler plug-ins. (http://pedro2.spytech.cz/zmoldeler) 
 
Estas imágenes deben ser cuadradas y sus dimensiones deben ser: 256, 512, 1024 or 2048 
pixels. Es decir: 256x256, 256x512, 512x512, 512x1024 ...  
 
Para hacer esto, abre la fotot con tu programa favorito de edición de imágenes (The gimp, 
adobe photoshop, paint shop pro...), entonces cambia el tamaño del lienzo de la imagen 
(redondea el tamaño a la dimensión más cercana 256, 512, 1024 or 2048 pixels) manteniendo 
la imagen centrada. Finalmente guarda como BMP, TGA o PNG (o JPG). 
 
Ahora en ZModeler puedes cargar la imagen usando el menú que hay arriba a la izquierda en 
la vista, entonces haz click con el botón derecho sobre el pequeño rectángulo y en el menú que 
aparecerá elige: Backgroung -> Image -> Load Image, entonces aparecerá el gestor de 
texturas. Presiona Add... y busca tu imagen. Finalmente haz click sobre oK. 
Ahora ya tienes la imagen en el fondo. Puedes modificar esta imagen con el image background 

control . Presiona este botón y entonces haz click con el botón izquierdo y arrastra el ratón 
para mover la imagen. Con click con el botón derecho y arrastrar puedes hacer grande o 
pequeña la imagen. 
 
Puedes ver esto en la siguiente imagen que he creado con Adobe Photoshop:  
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Moviendo esta imagen y poniéndola debajo del nose cone y el alerón delantero del coche 
original de gp4. 
Como importar el coche está explicado en el siguiente apartado: crear la malla 3D)  

 
 
 
Ya podemos continuar con el siguiente paso del tutorial. 

Construye tu coche para GP4  Vicente Martí Centelles 



Construye tu coche para GP4     |      http://www4.uji.es/~al063357        |        Vicente Martí |        27 

 
 
Crear la malla 3D  
 
Primero de todo tenemos que importar el coche de gp4, para hacer esto ves a file -> import. 
Importa el lod_0 y guarda como car1.z3d. 
Importa el lod_4 y guada como car_lod_4.z3d.  
Puedes ver la diferencia en el detalle (nº de polígonos) de la malla entre el lod_0 y el 4 en la 
siguiente imagen:  

 
 
 
Ahora tenemos que hacer algunos ajustes en ZModeler: deselecciona el normals automatic 
update y extended mode, selecciona flat shading.  

and 
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Nosotros solo vamos a crear una parte del alerón, por ejemplo la izquiereda. (la otra parte es 
una copia de esta)  
 
Primero de todo esconde todos los objetos. Entonces vamos a crear una superficie plana en la 
vista superior (top view) Para hacer esto selecciona Create -> Surface -> Flat. Haz click con el 
botón derecho y arrastra (crea un rectángulo sobre uno de los alerones en el alerón delantero). 
Entonces escribe 0 horizontal steps y 6 vertical steps y el nombre del alerón por ejemplo wing1. 
Vas a ver esta superficie plana sobre tu foto.  

 
 
 
A continuación pasa al nivel de vértices y ajusta la superficie plana a la foto en la top view:  

 
 
 
Y con el gird snapper , pon los vértices cerca del centro de los ejes ( el gird sanpper hace 
que cuando arrastras algo con el ratón sea magnéticamente atraido hacia la linia de la parrilla 
más cercana). 
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Este paso es para que la otra parte del alerón case perfectamente con esta. 
Seguidamente, ajusta la superficie plana con la foto en la front view:  

 
 
 
Copia la superficie plana (wing1) y llamala wing2. Reorienta este objeto en objects level y 
muevelo hacia abajo en la front view en la dirección vertical ,[V]. (de esta forma solo podemos 
mover el wing2 hacia arriba y abajo). 
 
 

 
 
 
Selecciona estos dos objetos, wing1 and wing2 (en objects level) y ves a Create -> Objects -> 
Unite Select, haz click en cualquier sitio y escribe el nombre del nuevo objeto en la caja que 
aparecerá, por ejemplo wing. 
 
El próximo paso es crear el contorno de estas superficies. Para hacer esto pasa al vertex level 
y ves a Create -> Faces -> Strip. En la front view crea una superficie como en la foto (debes 
hacer el mismo numero de pasos en esta superficie, quiero decir, el mismo numero de vértices 
(en la imagen está muy claro). Para parar mantén presionado CTRL y haz click.  

 
 
 
Selecciona todos los vértices de la superficie creada y presiona el SEL mode, ahora mueve 
estor vértices cerca de la parte delantera del alerón en la top o left view (esto es para hacer el 
proceso de snapp más fácil). 
 

Ahora presiona el botón de vertex sanpper , (esto hace que cuando mueves algo con el 
ratón sea magnéticamente atraído hacia el vértice más cercano. 
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Selecciona Modify -> Move y mueve el vértice de la superficie hacia la parte superior y inferior 
del alerón en la User View. Haz lo mismo en todos los vértices de la superficie:  

 
 
 
 

 
 
 
A continuación podemos calcular los vectores normales. Para hacer esto pasa al objects level, 
ves a Surface -> Normals -> Calculate. Para poder ver el sombreado hay que desselecionar el 
flat shading. Comprobamos en la 3D view que el sombreado es correcto.  
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Haciendo lo mismo para el resto del alerón el resultado es:  

 
 

 
Y para la parte lateral del alerón::  
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Finalmente tenemos en el alerón izquierdo delantero acabado pero necesitamos crear el alerón 
derecho delantero. Para hacer esto vamos a copiar el alerón izquierdo y nombrarlo como 
alerón derecho. Pasamos el eje (X) al centro, para hacer esto ves a Display -> Reset Axis y el 
eje se va a poner en el origen (X=0, Y=0, Z=0). 
En la front view en Horizontal axis mode [H] y objects level, ves a Modify -> Mirror y haz click 
sobre el objeto del aleron derecho delantero. El siguiente paso es reorientar este objeto: Modify 
-> Reorient y haz click en el objeto. Finalmente tienes que cambiar de dirección los normales: 

• selecciona Modify -> Reorient mantén presionado CTRL y haz click en el objeto  
o  

• selecciona Surface -> Normals -> Flip y haz click en el objeto  
 
El resultado es:  
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Ya hemos creado la malla del alerón delantero. 
 
Para finalizar este capítulo del tutorial os tengo que decir que cuando se crea el cuerpo 
del coche este debe estar todo en un objeto. Esto es muy importante para conseguir un 
buen sombreado y unas buenas reflexiones en el coche. (una explicación se encuentra 
en el apartado de Normals de este tutorial). 
Entonces una vez creado el cuerpo del coche en un objeto, calcula los normales y haz 
una copia de seguridad. Finalmente ya puedes dividir el cuerpo del coche en los 
diferentes objetos requeridos en gp4.: cockpit, engine, left_front_fin, left_sidepod, 
nose_cone and right_sidepod. 
Recuerda que los objetos se deben ordenar tal como aparecen en la lista de objetos.  
 
La siguiente imagen muestra como afectan las modificaciones que hemos creado sobre 
el coche original comparándolo con este. El resultado es bueno como se observa:  

 

 
Algunos consejos para crear una buena malla  
 
Intenta hacer una malla limpia, quiero decir hacer una estructura de polígonos rectangular. Ya 
que las estructuras de polígonos rectangulares tienen unos buenos normales (piensa en la 
superficie plana creada con Create -> Surfaces -> Flat, esta superficie plana tiene una 
estructura de polígonos rectangular). Y unos buenos normales significa un buen sombreado y 
unas buenas reflexiones. 

• Un coche original de GP4 tiene sobre unos 2200 polígonos, por tanto debes intentar 
usar los mínimos polígonos necesarios. Esto es porque si usas muchos polígonos el 
coche será muy bueno con una malla perfecta, pero al ponerlo en el juego va a usar 
muchos recursos de la CPU y la frame-rate va a disminuir. 
Por tanto piensa que partes del coche necesitan más polígonos y cuales menos para 
usar los mínimos polígonos posibles.  

• Recuerda que la base de nuestro coche son las fotos, por tanto necesitamos buenas 
fotos para poder crear un buen coche. 

• Para modelar superficies de forma fácil, crea una superficie plana y añadele una 
tercera dimensión. (este es el proceso usado para crear el alerón delantero). 

• Recuerda que solo necesitamos crear medio coche, el otro es una copia de esta 
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Ajustar los normales para conseguir un buen sombreado y 
unos buenos reflejos.  
Primero de todo, nosotros deberíamos saber que es un normal. Un normal es un vector (con 
una longitud y una dirección). 
Cada vértice tiene un normal, y lo más importante es que normales afectan a las reflexiones de 
la luz en el coche. 
Lar dirección del normal indica la dirección en que la luz será reflejada por la superficie, por 
tanto si tu ves la superficie en la dirección de normal toda la luz será reflejada.  
 
 

 
 
 
Pero si tu ves la superficie de otra dirección diferente a la dirección del normal la superficie 
refleja menos luz. Cuanto mayor es la diferencia entre las direcciones menos luz se refleja. 
Esto se aprecia en la siguiente imagen:  
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La longitud del normal indica cuanta luz es reflejada en la dirección del normal. Cuanto más 
corta es la longitud del normal, menor es la reflexión. La siguiente imagen muestra esto 
(izquierda: normales largos (normalizados); derecha: normales cortos):  

 
 

 
En este tutorial solo vamos a trabajar con normales normalizados (todos los normales van a 
tener la misma longitud).  
Vamos a usar el método de cálculo y el de proyección para obtener un bonito sombreado y 
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unas buenas reflexiones en nuestro coche de gp4.  
 
Ahora vamos a ver algún ejemplo de diferentes tipos de superficies:  
NOTA: en todo el tutorial vamos trabajar con el normals automatic update y extended 
desactivados.  

 
 
 
 
 
 
 
Una superficie un poco curvada.  
 
Esta es una superficie con los normales calculados (Surface -> Normals -> Calculate). El 
sombreado y la reflexión es buena, se puede ver en las siguientes imágenes:  
 
Esta es la superficie:  

 
 
 
Y su sombreado:  
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Pero ahora vamos a hacer algunas modificaciones a esta superficie (1 solo objeto), 
concretamente la vamos a dividir en 2 nuevos objetos y vamos a calcular los normales. 
El sombreado de la superficie resultante es:  
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Se observa que el sombreado no es bueno, y además parece que el objeto tiene una linia en la 
cual el sombreado cambia.  
 
Ahora vamos a ver la reflexión de esta superficie. La primera imagen es el objeto original, y se 
puede observar que tiene una buena reflexión que es suave y continua.  
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Pero la superficie dividida en dos objetos tiene una reflexión mala que no es continua.  
La siguiente imagen muestra esto:  
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La explicación de esto son los normales. En la primera imagen (superficie original formada por 
un solo objeto) se puede ver que el centro hay un solo vértice (vértice simple).  
Pero en la superficie dividida que está formado por dos objetos, en el centro hay dos vértices 
(doble vértice).  
Por tanto el sombreado discontinuo y la reflexión discontinua es debida al doble vértice. Esto es 
importante porque diferentes objetos no pueden compartir vértices y esto es un problema 
cuando queremos obtener un sombreado continuo y una reflexión continua en un coche para 
gp4 que está formado por diferentes objetos. A lo largo del tutorial veremos como solucionar 
este problema y ver cuando usar en una superficie vértices simples o dobles.  

 
Vértice simple.  
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Vértice doble.  

 
 
 
 
Una superficie muy doblada.  
 
Esta superficie tiene los normales calculados. (Surface -> Normals -> Calculate). Como se 
observa, esta superficie tiene un borde afilado (es decir con un ángulo casi que recto). 
Veamos los problemas que tienen este tipo de superficies:  
Esta es la superficie con su sombreado:  
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La imagen anterior muestra que el sombreado no es bueno, sobre todo en el borde afilado. 
Además, las reflexiones tampoco no son buenas como muestra la siguiente imagen:  

 
 
 
Esto es porque una superficie con un borde afilado debería se como dos superficies diferentes 
que reflejen la luz de forma distinta. Para solucionar esto vamos a dividir la superficie en dos 
objetos diferentes (por el borde). 
Primero, veamos los normales de esta superficie (la superficie original):  
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Se puede ver que las direcciones de los normales próximos al borde son muy diferentes. Para 
solucionar este problema como hemos dicho vamos a "partir" la superficie en dos.  
Para dividir la superficie en dos objetos: pasar al nivel de caras (polígonos) y Select -> Quadr, 
entonces seleccionar las caras de una de las nuevas superficies:  

 
 
 
Después ir a Create -> Objects -> Detach, activar del modo SEL y hacer click en la vista. 
Entonces, escribir el nombre del nuevo objeto en la caja de diálogo que aparecerá.  
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Ahora tenemos la superficie dividida en dos objetos. Si ves el sombreado de esta superficie 
formada por dos objetos puedes ver que el sombrado es el mismo. Esto es porque los 
normales son los mismos ya que no los hemos modificado después de dividir la superficie en 
dos objetos y tenemos desactivado el normals automatic update and extended mode.  

 
 
 
Por tanto ahora ya podemos unir los dos objetos que forman la superficie en uno solo para 
tener un solo objeto (como en la superficie original que esta formada por un solo objeto). 
Para hacer esto, selecciona los dos objetos que forman la superficie en el nivel de objetos, 
entonces ves a Create -> Objects -> UniteSelect y haz click en la vista (notar que la vista es la 
pantalla en la que estamos trabajando: vista desde arriba, abajo, derecha... es decir cada uno 
de las cuatro partes en la que está dividido la pantalla de ZModeler). Escribe el nombre del 
nuevo objeto en la caja de diálogo que aparecerá, finalmente el resultado es un solo objeto a 
partir de los dos objetos seleccionados con un borde formado por vértices dobles.  
Este proceso se conoce como el método del vertíce doble. 
 
Pero para conseguir la reflexión correcta tenemos que calcular los normales. Para hacer esto ir 
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a Surface -> Normals -> Calculate y en el nivel de objetos hacer click en el objeto, finalmente 
en la vista 3D veremos la siguiente imagen:  

 
 
 
Ahora tenemos un borde afilado en el vista 3D y este objeto parece que tenga dos superficies 
independientes que reflejen la luz de forma diferente y entre ellas hay una discontinuidad del 
sombreado. La explicación es fácil, las superficies con doble vértice tienen una 
discontinuidad en el sombreado.  
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La imagen anterior muestra que la superfície de la derecha (la vertical) y la superficie de la 
izquierda tienen un "juego" diferente de normales porque no comparten ningún vértice y 
entonces se trata de una superfície con doble vértice que tiene un borde afilado.  
Por tanto las superfícies con vértices dobles son buenas si queremos hacer dos superfícies 
independientes con un borde afilado y un sombreado discontinuo. 
 
Como es de esperar las superfícies con vertices dobles además de tener un sombreado 
discontínuo tienen una reflexión discontinua, la siguientes imagenes muestran esto. La primera 
es de la superficie original ya la segunda de la superficie con vertíces dobles: 
 
Superficie original, con una reflexión contínua:  

 
 
 
Superficíe con vertice doble, con una reflexión discontínua:  

Construye tu coche para GP4  Vicente Martí Centelles 



Construye tu coche para GP4     |      http://www4.uji.es/~al063357        |        Vicente Martí |        47 

 
 
 
 
 
Para acabar con esta parte del tutorial podemos ver una comparativa de los normales de la 
suprfície original y la superfície con vetíces dobles. 
Superficie original, con un sombreado contínuo y una reflexión contínua:  
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Superficie con doble vértice, con un sombreado discontinuo y una reflexión discontinua en el 
borde:  

 
 

 
Finalmente la conclusión de este tutorial es que cuando tengamos bordes afilados podemos 
solucionar este problema usando el método de los vértices dobles. 
Pero si lo que queremos es obtener un lado afilado con una reflexión continua y un sombreado 
continuo tenemos que incrementar el nº de polígonos de la zona del borde sin usar el método 
de los vértices dobles. El resultado es un borde "redondeado" con una reflexión continua y un 
sombreado continuo. 
Las siguientes fotos muestran una superficie muy doblada con un borde con una reflexión 
continua y un sombreado continuo con un nº de polígonos elevado en la zona del borde:  
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Para concluir esta parte del tutorial veamos un resumen de lo dicho anteriormente: si queremos 
una superficie con un sombreado y unas reflexiones continuas no tenemos que usar la técnica 
de los vértices dobles, simplemente incrementar el nº de polígonos cuando sea necesario. 
Pero si nuestra superficie pertenece a dos o más objetos la cosa no es tan fácil. Primero si 
tenemos una superficie que acabamos de crear y la queremos dividir en varios objetos no hay 
ningún problema en conseguir un sombreado y unas reflexiones continuas. Simplemente crear 
el objeto, calcular los normales y dividir el objeto en los nuevos objetos y no recalcular los 
normales a los nuevos objetos (recordar que hay que tener desactivado en normals automatic 
update). No recalcular los normales es muy importante porque si los recalculamos obtenemos 
una superficie con un sombreado y unas reflexiones discontinuas.  
Por ejemplo nosotros vamos a usar esta técnica para hacer el cuerpo del coche de GP4 
(recordar que un coche de GP4 tiene un montón de objetos).  
 
 
 
 
 
El alerón delantero de un coche de GP4.  
 
En la sección de crear la malla 3D se ha explicado como crear el alerón delantero y aquí vamos 
a continuar con este trabajo ajustando los normales para nuestro alerón. 
 
En la sección de crear la malla 3D se ha explicado como crear el alerón usando la técnica de 
los vértices dobles, pero el siguiente ejemplo muestra el resultado que hubiéramos obtenido si 
no se hubieran usado estos vértices dobles, es diecr si la superficie superior y inferior del 
alerón compartieran los vértices con la superficie lateral. 
 
Se puede comprobar en la siguiente imagen que el conjunto de normales del alerón es malo ya 
que los normales están orientados hacia direcciones muy diferentes y por tanto el sombreado y 
las reflexiones es malo.  
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Para solucionar este problema basta con dividir la parte superior y inferior del alerón de la 
superficie lateral. Para ello se ha usado el metode explicado anteriormente de seleccionar la 
supferficie, ir a Create -> Objects -> Detach, activar del modo SEL y hacer click en la vista. 
Entonces, escribir el nombre del nuevo objeto en la caja de diálogo que aparecerá. 
A continuación se unen los objetos en uno solo y se calculan los normales. El resultado es:  

 
 
 
Se puede ver que los normales ahora esta bien, apuntan más o menos hacia la misma 
dirección. 
 
El siguiente paso es crear la otra parte del alerón como se explicó en la parte de crear la malla 
3d. Se vemos en la vista 3D el alerón delantero al completo se observa que el sombreado y la 
reflexión son buenos.  
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Otra forma de ajustar los normales (usando como base el alerón con los vértices dobles). Para 
ajustar los normales, seleccionar la parte superior del alerón, poner el eje (la X gris) en un lugar 
como en la imagen (para poner el eje en cualquier lugar, poner el ratón en el lugar deseado y 
presionar " . "). Activar el modo SEL y entonces seleccionar la herramienta Surface -> Normals 
-> Projection y hacer click en la vista superior (top view). 
Los normales del aleron delantero van a tener un buen ajuste en la vista 3D, y como se puede 
observar el sombreado y las reflexiones son buenas:  

 
 

 
Las diferencias entre los normales calculados y los proyectados se muestran en la siguiente 
imagen:  
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Por tanto es tu decisión usar un método o otro (calcular o proyección) para ajustar los 
normales.  
 
 
 
 
El cuerpo del coche de GP4.  
 
En la siguiente imagen se puede ver el problema que surge al tener diferentes objetos que 
forman una superficie que debe tener un sombreado continuo y una reflexión continua. 
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Para solucionar este problema tenemos que unir todos los objetos del cuerpo del coche en un 
solo objeto, a continuación unir los vértices dobles (ver explicación más abajo), calcular los 
normales y finalmente dividir el cuerpo del coche en diferentes objetos sin recalcular los 
normales después de dividir el cuerpo del coche. 
El resultado es un coche con un sombreado continuo y unas reflexiones continuas. La siguiente 
imagen muestra el coche después de aplicarle todo lo dicho anteriormente:  

 
 
 
Para unir los vértices dobles en uno sólo los pasos a seguir son:  

• Pasar al nivel de vértices  
• Activar el modo MUL  
• Activar el modo SEL  
• Ir a la herramienta Select -> Single  
• Ir a la herramienta Create Objects -> Unite select  

Entonces hacer click con el botón izquierdo para unir los vértices próximos (vértices dobles) y 
después de esto hacer click con el botón izquierdo para unir los vértices seleccionados (Vamos 
a pasar de tener dos vértices a tener uno solo).  
 
Después de unir todos los vértices dobles pasar al nivel de objetos y calcular los normales, 
finalmente dividir el cuerpo del coche en diferentes objetos.  
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Mappear el coche 
 
En esta parte del tutorial se explica como mapear el coche. 
En esta parte del tutorial se explica un método para mapear el coche de forma rápida usando 
una paleta o plantilla creada con algunos polígonos.  
 
Veamos los pasos a seguir para mapear el coche:  
 
1. Primero hacer dos capturas de pantalla del coche como las siguientes: (una de la vista 
superior y la otra de la vista de lado):  

 
Vista de lado  

 

 
Vista superior  

 
 
2. Poner las diferentes partes del coche que vamos a mapear en el material (la textura que 
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tiene un tamaño de 1024 x 1024 pixels). 
Por ejemplo yo he mapeado los laterales del motor o cubre radiadores (sidepods de ahora en 
adelante), la nariz del coche y el motor en el primer material (tga 1). En la siguiente imagen se 
puede ver esto:  

 
Rellenar la textura con algunas partes del coche de las capturas de pantalla.  

 
 
Seguidamente debemos hacer lo mismo con el 2º material para mapear las partes que nos 
faltan del coche (partes grandes, no detalles como aleroncitos...): los laterales de la nariz del 
coche, el alerón delantero...  
 
Finalmente para mapear pequeños detalles del coche (el nº del coche, pequeños alerones, ...) 
vamos a usar el 3r material que lo vamos a preparar para mapear de una forma similar al 
material 1 y 2.  
En las siguientes imágenes se puede ver que en el 3r material he puesto un montón de 
cuadrados. Estos cuadrados nos van a servir como referencia para mapear los pequeños 
detalles del coche de una forma fácil.  
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Como decíamos, estos pequeños cuadrados nos sirven como guía para mapear los pequeños 
detalles del coche, la siguiente imagen muestra como se han mapeado diferentes partes del 
coche sobre esta plantilla de cuadrados:  
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3. Ahora, en el material 1 (tga1) y en el material 2 (tga2) hay que dibujar algunos polígonos con 
diferentes colores para diferenciar las diferentes partes del coche (usando como referencia los 
diferentes partes del coche que hemos copiado y pegado en el segundo paso). 
 
Estos polígonos serán nuestra referencia cuando mapeemos el coche en ZModeler.  

 
 
 
4. Empezar a mapear el coche en ZModeler (un buen tutorial es el Mapping cars for GP4 by 
Auradrummer, que se puede descargar en gpxcarpainting). 
 
Veamos los pasos a seguir para mapear el coche. Primero debemos saber que tenemos que 
mapear caras por tanto trabajaremos en el nivel de caras.  
 
Para mapepar un grupo de caras, seleccionar las caras en el nivel de caras (si estas caras 
pertenecen a diferentes objetos, recordar que en la sección de ZModeler de este tutorial se 
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explica que para seleccionar caras o vértices de diferentes objetos debemos seleccionar los 
objetos deseados en el nivel de objetos, entonces activar el modo SEL y pasar al nivel de caras 
o de vértices, hacer click en la selección y ahora ya se puede seleccionar los vértices o caras 
deseadas) recordar activar el modo SEL. 
 
El siguiente paso es asignar un material a las caras seleccionadas (recordar activar el modo 
SEL), para hacer esto ir al material editor y asignar el material a la selección haciendo click en 
el botón Assign to Selection.  

 
 
 
Después de esto tienes que asignar el UV a las caras seleccionadas (recuerda activar el modo 
SEL). 
Para hacer esto, ir a Surface -> Mapping -> AssignUV y hacer click en la vista deseada. 
Recordar también que se quieres remapear un área ya mapeada primero tienes que borrar el 
UV mapping actual de las caras deseadas, para hacer esto: selecciona las caras en el nivel de 
caras, ves a Surface -> Mapping -> ResetUV (recuerda activar el modo SEL) y haz click en la 
selección.  
El siguiente paso es asignar el UV mapping de forma habitual a las caras seleccionadas.  
 
Después de asiggnae el UV mapping en la UVMapper view se puede ver el mapeado el estas 
caras. 
 
Recordar que para escalar (reducir casi siempre) debemos usar la numeric box #1. Para usar 
esta caja, poner el nº que quieres reducir el tamaño del area que hemos mapeado. El mejor nº 
es el 60% (gràcias a Bojan Tarticchio por decirme esto). 
Por tanto poner 60 en esta caja y arrastrar el ratón de forma habitual, el tamaño del area 
mapeada se reducirá un 60% exactamente por pasos. Todos los objetos mapeados se deben 
reducir un 60%.  
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La siguiente imagen muestra el proceso de mapear una trozo del coche: seleccionar un grupo 
de caras, asignar un material, mapear las caras (haciendo click en la vista superior), reducir el 
area mapeada un 60% con la numeric box #1 y finalmente ver el resultado en el vista 3D. 
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5. La ventaja de los polígonos de colores es que cada area mapeada se deferencia 
perfectamente grácias a estos colores.  
 
6. Finalmente cuando tengamos todo el coche mapeado podemos mostrar el mapeado de 
todas las superfices mapeadas en cada material (se puede leer también el tutorial How to find 
out the mapping of a gp4 car by Max Downforce, que se puede descargar en gpxcarpainting). 
 
Para mostrar el mapeado del coche:  

• Seleccionar todos los objetos del coche en el nivel de objetos.  
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• Pasar al modo SEL y al nivel de caras, hacer click con el botón derecho en el coche.  
• Ir a Select ->By Material y seleccionar el material al cual le quieres averiguar el 

mapeado, por ejemplo el vte_1.tga. Vas a ver que las partes del coche que pertenecen 
a este material son seleccionadas.  

• Ahora ir a Surface -> Mapping -> AssignUV (como ya sabemos si aplicamos Assign UV 
a una cara ya mapeada no se le asigna un nuevo mapeado, solo se muestra el 
mapeado en la vista de UVMapper ).  

• Finalmente ir a la vista UVMapper para poder ver el UVMapping del material 
seleccionado.  

 

 
 
Para acabar tenemos que hacer una captura de la pantalla de la malla mostrada en el 
UVmapper con la mayor resolución que podamos para poder pintar el coche. 
Para hacer la captura de pantalla, primero hacer el UVMapper que ocupe toda la 
pantalla presionando "f" en el teclado. Entonces hacer que el área mapeada (toda la 
textura) ocupe tada la pantalla. Tomar la captura. Ir a tu programa favorito de edición 
gráfica (photosop, the gimp... ) y pegar la captura. Con la herramienta de selección 
rectangular seleccionar la parte interior del área del material (quiero decir que no hay 
que seleccinar la linea del borde gris). 
Con la herramienta de borrado mágica y sin el antialiasing, borrar todo el fondo pero no 
la malla. Cambiar el tamaño de la imagen a 1024 x 1024. Finalmente pintar cuatro 
pequeños pixeles de color blanco en las esquinas de la imagen (esto es para evitar 
problemas al copiar y pegar la imagen, por ejemplo en adobe photoshop cuando 
seleccionar una imagen con algunas transparencias, photoshpo automáticamente 
ajusta la selecciona al área pintada.) y finalmente guarda la imagen.  
Felicitaciones, ya tenemos el primer paso para crear una buena plantilla para pintar el 
coche. 
 
En el punto 13 esta explicado como hacer la plantilla a partir de esta malla.  
 
7. Si cuando mostramos el mapeado del coche como se ha explicado en el punto 
anterior y vemos que es incorrecto (por ejemplo una superficie está en un lugar 
incorrecto), no hay ningún problema, se puede solucionar fácilmente.  
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Veamos como se puede solucionar. En la siguiente imagen se puede ver que la 
superficie del motor esta desplazada. 

 

 
 
Para solucionar esto, pasar al nivel de vértices y seleccionar todos los vértices de esta 
superficie: 

 

 
 
Ahora activar el modo SEL y ir a Modify -> Move. Entonces cambiar de lugar la 
superficie que estaba mal mapeada. En la siguiente imagen se puede ver que ahora el 
mapeado es correcto.  
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Además de cambiar de lugar podemos aplicar otras operaciones como escalar, rotar, 
hacer una imagen especualar (mirror), reorientar... a la superficie con los vértices 
seleccionados. 
Por tanto se hacemos alguan error cuando estamos mapeando, lo podemos solucionar 
rápidamente como hemos mostrado en este punto.  
 
8. A veces es muy útil escribir alguna cosa en la textura que estamos mapeando. 
Entonces podemos ver si estamos mapeando en la posición correcta o no.  
Por ejemplo al mapear el motor podemos equivocarnos y mapear en una posición 
incorrecta (imagen superior), pero como vemos en la vista 3D que la palabra Left se lee 
al reves de lo normal, cambiamos la posición y el mapeado es correcto (imagen 
inferior). 
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9. Hay otro tipo de superfícies como las suspensiones, la parte inferior del coche... que 
están mapeadas con fibra de carbono. Para mapear este tipo de superfíces vamos a 
usar un método llamado "texturas baldosa". 
El material que vamos a usar es un materal de color negor con unas líniea de color 
gris.  
 
Para mapear estas superfíces, selecciona todas las superfíces que quieras mapear con 
fibra de carbono:  
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entonces asigna dicho material a la selección y ves a Surface -> Mapping -> AsingUV y 
haz click en la vista en la que las superficies seleccionadas estén más visibles (por 
ejemplo para mapear el fondo del coche hacer click en la vista superior, para mapear 
los paneles laterales del aleron trasero hacer click en la vista lateral (izquierda o 
derecha),...) 
En la vista del UV mapper van a aparecer las superficies mapeadas, ahora las puedes 
hacer grandes o pequeñas... (no importa si se salen por fuera de la textura). El 
resultado se muestra en la siguiente imagen:  
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I finalmente el resultado en la vista 3D es:  
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Viendo en la vista 3D el efecto de las líneas de color gres podemos ir haciendo grande 
o pequeña el área mapeada en el UVmapper para obtener un buen resultado. 
 
Repetir esto para todas las superficies con fibra de carbono.  
 
Otro y muy útil método para mapear la partes con fibra ce carbono del coche 
(gracias a Bojan Tarticchio por contar esto en el foro de gpxcarpainting) 
 
Primero crear un patrón en la textura con líniea grises y negras (1 pixel de ancho cada 
liniea) muy ancho (unos 1024 pixels).  
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Ahora seleccionar la parte del coche a la que le queramos asignar la fibra de carbono, 
y asignar el material y el UV mapping.  
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Reducir el tamaño del objeto un 60% poniendo en la numeric box #1 un 60.  

 
 

 

 
 
Poner el eje ( X ) en el centro del alerón delantero en la vista del UVMapper poniendo 
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en el lugar deseado el ratón y haciendo click con " . " en el teclado. 
Ahora rotar el objeto 45º usando la numeric bar #1.  

 
 

 

 
 
Mover el objeto al centro del patrón de color negro de la parte inferior de la texura.  

 
 

 

 
 
Finalmente, poner el centro del eje ( X ) en el centro del alerón delantero en el 
UVMapper. 
Escalar verticalmente (seleccionar el mode de eje V) y reducir hasta que la superficie 
mapeada este dentro del patrón:  
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Finalmente el resultado es una bonita parte mapeada con fibra de carbono:  

 
 

 

 
 
Este método es muy útil porque no se necesita mucho espacio en la textura y no 
necesitamos ninguna textura extra (un nuevo material) para mapear las partes con fibra 
de carbono. 10. El siguiente paso es acabar de mapear el coche con los pasos que se 
han explicado en esta sección.  
 
11. Para mapear más fácilmente se puede copiar en un papel los poligonos que hay 
en cada textura (tga1, tga2 y tga3) y con un lápiz ir dibujando y nombrando las partes 
que se van mapeando en estos polígonos. 
De esta forma nos evitamos problemas como mapear dos partes del coche en el 
mismo lugar de la textura. 
 
12. El paso final es mapear los números del coche 2 (para que el coche 1 y el 2 no 
tengan el mismo nº). 
Para hacer esto haz dos copias de tu coche y nómbralas como: car1 y car2. Ahora 
remapear los números del coche 2 (car2) y guarda los cambios. De esta forma tan 
sencilla tendremos los coches con los números diferentes.  
 
13. En este punto se explica como crear una buena plantilla para poder pintar el coche 
con facilidad (la explicación esta hecha para adobe photoshop pero para otros 
programas de edición gráfica es lo mismo pero aplicando los pasos con las 
herramientas disponibles en cada programa de edición gráfica.  
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Primero de todo tenemos la malla en nuestra textura (ver la explicación de como 
averiguar el mapeado en el punto 6). La malla en la textura es la siguiente foto (las 
dimensiones de la textura son de 1024 x 1024 tal como se explica en el punto 6):  

 

 
 
Ahora pinta la parte exterior de la malla de la textura en un color que no vayas a usar 
en el coche, por ejemplo ya he usado este verde claro:  

 

 
 
Después selecciona con la barita mágica la parte exterior de la malla del material.  
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A continuación crea una nueva capa (new layer) con la selección. 
Para hacer esto: haz click con el botón derecho del ratón y selecciona Layer via cut en 
el menu que aparecerá.  

 

 
 
Ves a la nueva capa y selecciona la parte verde, ahora invierte la selección para 
seleccionar las partes del coche (click con el botón derecho y selecciona Select inverse 
en el menú que aparecerá).  
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Ahora expande la selección un poco para evitar problemas. Por ejemplo 3 pixels.  

 

 

 

 
 
El paso final es pintar las superficies del coche con el color deseado, es decir, pintar la 
selección. Yo he decidido pintar el coche de color azul. 
 
El resultado es una bonita plantilla que nos permite pintar el coche con total facilidad:  
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Haciendo lo mismo para las otras texturas del coche obtenemos la plantilla de todas las 
texturas:  
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El siguiente paso es pintar el coche usando esta plantilla. Para ello leer la sección de 
pintar el coche de este tutorial.  
 
 
 
Por cierto, para conseguir una plantilla muy precisa posemos usar algunos plug-ins 
para ZModeler que nos permiten exportar la plantilla en formato eps. 
Se puede descargar en: ZModeler plug-ins  (http://pedro2.spytech.cz/zmodeler) 
Espero que os sea útil.  
 
 

 

 

Construye tu coche para GP4  Vicente Martí Centelles 

http://pedro2.spytech.cz/zmodeler


Construye tu coche para GP4     |      http://www4.uji.es/~al063357        |        Vicente Martí |        79 

NOTA: mapear el car_lod_4  
Hay que recordar que tenemos mapear el car_lod_4: 

 

 
 
Este coche tiene muy poca resolución y lo vamos a mapear para ver los colores 
correctos del coche: el color de la nariz, el alerón delantero, el alerón trasero...  
Es decir lo vamos a mapear para ver el coche correctamente por los espejos 
retrovisores (ya que el car_lod_4 se usa casi exclusivamente para ver el coche en los 
retrovisores o cuando esta muy lejos). 
Normalmente el lod_4 tiene menos materiales que el lod_0, lod_1, lod_2 y lod_3. Por 
ejemplo este tiene el VTE_1.TGA and VTE_2.TGA pero no el VTE_3.TGA que lo tienen 
los otros lods. 
 
Es aconsejable mapear el lod_4 cuando el coche este acabado. La siguiente imagen 
muestra que el mapeado del car_lod_4 es horrible y necesita ser remapeado:  

 
 

 

 
 
Por ejemplo voy a explicar como mapear el alerón delantero.  
Seleccionar el alerón delantero (en el nivel de caras), activar el modo SEL, ir a surface 
-> mapping -> ResetUV para borrar el mapeado actual. A continuación ir a surface -> 
mapping -> Assign UV y acer click en la vista superior (top view) para asignar el 
UVmapping. Entonces vas a ver:  

Construye tu coche para GP4  Vicente Martí Centelles 



Construye tu coche para GP4     |      http://www4.uji.es/~al063357        |        Vicente Martí |        80 

 
 

 

 
 
El siguiente paso es ajustar el área mapeada a la textura. La siguinte imagen muestra 
esto:  

 
 

 

 
 
Y en la vista 3D se puede ver el resultado de nuestra acción sobre el alerón delantero:  

 
 

 

 
 
Remapeando todo el coche (que cuesta muy poco tiempo) conseguimos un bonito 
coche bien mapeado con los colores correctos:  

Construye tu coche para GP4  Vicente Martí Centelles 



Construye tu coche para GP4     |      http://www4.uji.es/~al063357        |        Vicente Martí |        81 

 
 

 

 
 
Por tanto a la vista de la imagen anterior veremos los colores correctos de nuestro 
coche por los espejos retrovisores.  
 
 
 
Algunos consejos de mapeado  
Primero de todo agradecer a Bojan Tarticchio por comentar este método en el foro de 
gpxcarpainting . 
 
Este método es muy útil para piezas contiguas del coche, es decir para las partes del 
cuerpo del coche. No es necesario hacer esto para los alerones y otras partes del 
coche.  
 
Para aplicar este método, primero seleccionar una pieza de nuestro coche, asignar un 
material y UV mapping. Reducir el tamaño a un 40% (para ello escribir 60 en la numeric 
box#1):  
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Finalmente desplazar este objeto al centro de la textura (área de mapeado).  
 
Hacer lo mismo para las otras partes del coche. 
Pero algunas superficies del coche necesitar ser rotadas 90º. Para hacer esto usar la 
numeric box #1. Después de esto mover esta superficie a la derecha de la textura:  

 
 

 

 
 
Haciendo lo mismo para la otra parte del coche y moviéndola hacia la izquierda ya 
tenemos todas las partes de la nariz del coche mapeadas. 
Para ver todas las partes mapeadas de este material, seleccionat todos los objetos del 
coche, activa el modo SEL, pasa al nivel de caras, ves a select by material y selección 
el material al que hayas asignado las partes mapeadas. Finalmente ves a Surface -> 
Mapping -> Assign UV y haz click en alguna vista. En el UVmapper vas a ver todas las 
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partes mapeadas (notar que cuando seleccionas una cara mapeada y vas a Surface -> 
Mapping -> Assign UV no borras el mapeado de esta cara, simplemente se muestra el 
mapeado en la vista de UVMapper.  
En el UVMapper veremos:  

 
 

 

 
 
Ahora pasar al nivel de vértices, activar el modo SEL y ir a Select -> Quad. Mover los 
vértices selecionados para llenar la textura dejando poco espacio libre.  

 
 

 

 
 
Seleccionando las otras partes y moviéndolas obtenemos una textura bien mapeada. 
El siguiente paso es dibujar una línea horizontal (1 pixel de ancho y no-antialiased), 
esta línea es un marcador.  
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El último paso es alinear el marcador en la vista 3D moviendo las partes mapeadas (la 
de la derecha y de la izquierda) en la vista del UVMapper. 
Por tanto selecciona una parte mapeada (pasa al nivel de vértices, activa el modo SEL 
y ves a Select -> Quad) y mueve los vértices seleccionados para encajar el marcador 
en la vista 3D.  
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Finalmente podemos pintar algunas líneas horizontales en la nariz y ver en el vista 3D 
que se ajustan perfectamente.  
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Los materiales de un coche de GP4  
Los materiales de un coche de GP4 original  
Cuando importas un coche de gp4 en ZModeler, en el material editor se pueden ver los 
materiales (este es un ejemplo del coche original de Benetton):  
 
COCKPIT_DAMAGE.TGA  
CARLIGHTMAPCH2.TGA  
CARLIGHTMAPCH3.TGA  
BENETTON_1.TGA  
BENETTON_2.TGA  
BENETTON_3.TGA  
 
 
Haciendo cambios a estos materiales 
Se pueden cambiar los nombres de BENETTON_1.TGA a VTE_1.TGA, 
BENETTON_2.TGA a VTE_2.TGA, BENETTON_3.TGA a VTE_3.TGA por ejemplo.  
Entonces se puede usar el coche para varios slots en GP4 (primero asegurate que el 
nombre de tus materiales no son usadas por ningún otro coche). 
 
Además, las texturas: CARLIGHTMAPCH2.TGA y CARLIGHTMAPCH3.TGA son muy 
pequeñas y son usadas por GP4. No importa si las borras porque al exportar el coche 
son creadas pero mejor dejarlas ahí. No están asignadas a ninguna parte del coche.  
 
Se puede usar cualquier material para cualquier objeto del coche cuando lo mapees en 
ZModeler. Además, se pueden añadir nuevos materiales como por ejemplo 
VTECARPARTS.TGA para aumentar el nivel de detalle en el coche o incluso un 
material para mapear la fibra de carbono.  
 
En el coche original de GP4, los materiales z_cockpit_right_mirror y 
z_cockpit_left_mirror estan asignados al material COCKPIT_DAMAGE.TGA. Para 
consegur que los espejos reflejen debes mantener este mapeado y asignarlo a este 
material.  
El mapeado de estos objetos se muestra en la imagen:  
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Además el z_cockpit_visor debe ser mapeado en el material COCKPIT_DAMAGE.TGA 
porque este objeto tiene uns transparencia en el juego. Las siguiente imagen muestra 
esto:  
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El otro objeto-z es el z_cockpit_interior que puede ser mapeado en cualquier material.  
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Pintar el coche  
 
Pintar el coche ( Sombreado de textura, Linias del coche y tornillos, Logos, Cockpit, Casco, 
Mecanicos e Ingenieros )  
 
 

Primero de todo necesitamos la plantilla para pintar el coche que la hemos creado en la 
sección de mapeado. 
Ahora hay que pintar estas texturas, añadir logos, sombrado de textura... y finalmente una 
alpha layer (una alpha layer en gp4 controla como la luz es reflejada: blanco -> toda la luz es 
reflejada y negro -> no se refleja luz). 
La mejor de crear una alpha layer es hacer esta capa de color gris y añadir algunas partes 
negras en las zonas que no deberían reflejar la luz.  

Primero de todo he pintado el fondo del coche de color azul:  

 
 

 

El siguiente paso es añadir sombreado de textura, líneas del coche y tornillos. 
El sombreado de textura, líneas del coche y tornillos añaden un gran realismo al coche por eso 
es imprescindible añadirlos a nuestras texturas.  

• Texture shading o sombreado de textura  
 
El sombreado de textura hace que el coche mejore mucho y que su sombreado sea 
mejor. 
Veamos un ejemplo de sombreado de textura para el deflector lateral: 
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Primero de todo tenemos que crear una nueva capa y nombrarla como 
sombreado_oscuro. Seleccionar con la herramienta de selección poligonal (poligonal-
lasso) la sección de la textura a la que le queremos añadir el sombreado. 
El siguiente paso es pintar el interior de esta selección con el pincel a una opacidad 
media en color negro. 
Después de esto, con la herramienta de borrar con una opacidad muy pequeña borrar 
un poco el área pintada para conseguir un degradado continuo y un buen sombreado.  
A continuación haz lo mismo para todas las partes de la textura que necesiten 
sombreado. 
Finalmente, cuando hayas acabado de pintar todas las sombras en la capa de 
sombreado_oscuro, aplica la herramienta de gussian blur para eliminar algunas 
imperfecciones en el sombreado.  
 
El resultado es:  

 

 

 

 

 
También se pueden crear reflejos (zonas más claras) de la misma forma, pero ahora 
hay que crear una capa que llamaremos sombreado_claro. 
Seleccionar con la herramienta de selección poligonal (poligonal-lasso) la sección de la 
textura a la que le queremos añadir el reflejo. 
El siguiente paso es pintar el interior de esta selección con el pincel a una opacidad 
media en color blanco. 
Después de esto, con la herramienta de borrar con una opacidad muy pequeña borrar 
un poco el área pintada para conseguir un degradado continuo y un buen sombreado.  
A continuación haz lo mismo para todas las partes de la textura que necesiten reflejos. 
Finalmente, cuando hayas acabado de pintar todos los reflejos en la capa de 
sombrado_claro, aplica la herramienta de gussian blur para eliminar algunas 
imperfecciones en los reflejos.  
 
Se puede ver el resultado de los reflejo en la nariz del coche de movistar:  
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• Lineas del coche y tornillos   
 
Estas líneas mejoran la apariencia de nuestro coche dándole un aspecto más 
realístico. 
Con líneas del coche me refiero al las líneas que dividen las diferentes partes del 
coche, por tanto piensa en las diferentes partes del coche antes de dibujarlas.  
 
Para crear esta líneas primero crea una nueva capa para las líneas y los tornillos 
oscuros. 
Vamos a crear las linias de color negro. 
Esta lines tienen 2 pixels de ancho (anti-aliased) y los tornillos unos 5 pixeles formando 
una cruz (también anti-aliased). 
Se usa el anti-aliased para hacer las lineas más suaves y que no queden dentadas. 
La siguiente imagen muestra las lineas oscuras:  
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Ahora, crear una nueva capa para las líneas y tornillos claros, serán de color blanco. 
Esta líneas tienen 1 pixels de ancho (anti-aliased) y los tornillos unos 5 pixeles 
formando una cruz (también anti-aliased). 
Desplazar un poco estas líneas blancas con respecto a las líneas negras creadas en el 
paso anterior.  
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Finalmente tenemos que ajustar la opacidad y el brillo de las dos capas (la capa de 
color negro y la de color blanco). 
El propósito de este paso es conseguir un buen efecto 3D sobre la textura de nuestras 
líneas y tornillos. 
Haciendo algunos ajustes con la opacidad y el brillo el resultado es:  

 

 

•  Logos  
 
En esta sección se explica como añadir algunos logos a nuestro coche. 
Para empezar tenemos que conseguir buenas imágenes de logos que podremos encontrar 
fácilmente en el buscador de imágenes de google ( www.google.com ) o en una página web 
donde hay infinidad de logos de todas las marcas del mundo www.brandsoftheworld.com .  
 
Una vez tengamos los logos se trata de in pegándolos sobre la plantilla usando diferentes 
capas. Es decir pegar las imágenes en una capa diferente a la del color de fondo. 
 
Otro consejo a la hora de añadir los logos es poner un poco de sombreado alrededor del logo 
para darle un poco más de vida, esto es, para que sea más impactante y realista. 
 
Las siguientes fotos muestran las texturas de mi movistar f1 car, en ellas se puede observar 
todo lo comentado anteriormente. 
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Y el resultado de estas texturas sobre el coche en ZModeler y en GP4 es: 
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Pintar el cockpit  

Necesitamos pintar el cockpit de nuestro coche para poder ver los colores correctos del coche 
en la cámara de abordo en gp4. 
Es fácil pintar un cockpit si tenemos una plantilla. Por ejemplo yo he usado la Original Cockpit 
Template by Nico de gpxcarpainting.  
A esta plantilla le acompaña un fichero de ayuda que explica como usarla, pero veamos los 
pasos a seguir: 
Primero de todo hay que saber que el cockpit solo tiene una textura (una archivo .tex): 
cp_myteam.tex . 
Por tanto solo tenemos que modificar este archivo. 

 

Plantilla del cockpit  

 

movistar cockpit  
 
Después de pintar la plantilla podemos ver el la vista 3D de ZModeler como nos a quedado 
nuestro trabajo:  
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movistar cockpit, vista 3D  

Para acabar nuestro trabajo, añadir una alpha layer a la textura (en formato tga), invertir la 
textura verticalmente (en el programa de pintado usar la opción voltear verticalmetne o flip 
vertically) y finalmente guardar la imagen en formato tga de 32 bits y codificado RLE (el 
codificado RLE es opcional pero reduce muchísimo el tamaño (espacie en disco)de la textura, 
por tanto es interesante este formato): cp_myteam.tga . 
Hacer una copia de seguridad de nuestro cars.wad. 
Crear los archivos .tex con TexResizer (cp_myteam.tex) y actualizar el cars.wad con 
WadUpdater (Iniciar WadUpdater, seleccionar el archivi cp_myteam.tex y el cars.wad, entonces 
hacer click en el botón de UpdateWad y automáticamente el cp_myteam.tex será actualizado 
en nuestro cars.wad). 
 
Con el TeamEditor se puede cambiar el nombre del slot de los equipos y esto afecta al nombre 
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de la carshape (car_myteam_car1_lod0.gp4 ...) y el nombre del cockpit (cp_myteam.tex). Por 
tanto se tiene que usar el nombre del slot de nuestro equipo (el mismo que para la carshape).  

 

 
movistar cockpit en gp4  

 
Pintar el casco    
 
También podemos pintar el casco del piloto de nuestro coche, para ello tenemos que editar 
algunos archivos .tex de nuestro cars.wad.  
Estos archivos son: 

Team 1 driver1_1.tex, driver1_2.tex for driver 1. 
driver2_1.tex, driver2_2.tex for driver 2.  

Team 2 driver3_1.tex, driver3_2.tex for driver 3. 
driver4_1.tex, driver4_2.tex for driver 4.  

Team 3 driver5_1.tex, driver5_2.tex for driver 5. 
driver6_1.tex, driver6_2.tex for driver 6.  

Team 4 driver7_1.tex, driver7_2.tex for driver 7. 
driver8_1.tex, driver8_2.tex for driver 8.  

Team 5 driver9_1.tex, driver9_2.tex for driver 9. 
driver10_1.tex, driver10_2.tex for driver 10.  

Team 6 driver11_1.tex, driver11_2.tex for driver 11. 
driver12_1.tex, driver12_2.tex for driver 12.  

Team 7 driver14_1.tex, driver14_2.tex for driver 14. 
driver15_1.tex, driver15_2.tex for driver 15.  

Team 8 driver16_1.tex, driver16_2.tex for driver 16. 
driver17_1.tex, driver17_2.tex for driver 17.  

Team 9 driver18_1.tex, driver18_2.tex for driver 18. 
driver19_1.tex, driver19_2.tex for driver 19.  

Team 10 driver20_1.tex, driver20_2.tex for driver 20. 
driver21_1.tex, driver21_2.tex for driver 21.  

Team 11 driver22_1.tex, driver22_2.tex for driver 22. 
driver23_1.tex, driver23_2.tex for driver 23.  
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Pero además tenemos que modificar los siguientes archivos de la carpeta GP4/cars: 

• driver9_1.tex, driver9_2.tex 
• driver10_1.tex, driver10_2.tex 
• driver21_1.tex, driver21_2.tex 

(no me preguntéis porque están estos archivos aquí. Pero si no se modifican no se ven las 
texturas correctas en gp4).  

Veamos un ejemplo práctico de como pintar el casco, la malla 3D (shape) del casco es: 

 

 

Ahora tenemos que pintar el casco usando la plantilla (de forma similar a como hemos pintado 
el coche).  
Es mucho más fácil pintar el casco que el coche como podréis comprobar. 
Solo se tienen que editar las siguientes texturas para pintar el casco: (driverX_1.tex, 
driverX_2.tex).  

 

 
driverX_1.tex  
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driverX_2.tex  

Finalmente podemos ver el resultado de nuestro trabajo en la vista 3D de Zmodeler, por 
ejemplo mi casco para el piloto del movistar F1 car es:  

 

Casco para el movistar F1 car  

Para finalizar nuestro trabajo, añadir una alpha layer y guardar en guardar la imagen en 
formato tga de 32 bits y codificado RLE (el codificado RLE es opcional pero reduce muchísimo 
el tamaño (espacie en disco)de la textura, por tanto es interesante este formato): driverX_1.tga 
and driverX_2.tga. 
Notar que no tenemos que invertir (voltear verticalmente) las texturas en este caso. Además os 
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tengo que decir que esto depende de cada tipo de plantilla y archivo .z3d que usemos para ver 
el casco en ZModeler. Es decir posiblemente si editáis el casco original tengáis que invertir 
verticalmente. De todas formas no os preocupéis, el único problema es que en gp4 veríamos 
las texturas invertidas, entonces nos daríamos cuenta del fallo y las invertiríamos sin ningún 
problema. 
Hacer una copia de seguridad de nuestro cars.wad.  
Crear los archivos .tex con TexResizer driverX_1.tex and driverX_2.tex) y actualizar el cars.wad 
con WadUpdater (Iniciar WadUpdater, seleccionar el archivo driverX_1.tex y el cars.wad, 
entonces hacer click en el botón de UpdateWad y automáticamente el driverX_1.tex será 
actualizado en nuestro cars.wad. Hacer lo mismo con el driverX_2.tex). 

Casco en gp4  
 

Casco en gp4  
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Casco en gp4  

 
 

Pintar mecánicos e ingenieros  

En este apartado vamos a pintar los mecánicos e ingenieros de nuestro equipo. 
Las texturas para los mecánicos e ingenieros están en el archivo anim.wad. Los archivos .tex 
para los ingenieros están localizadas en la carpeta (dentro del anim.wad) 
\animationdata\qualifying\skins y el nombre de estos archivos son: engin_myteam.tex. 
Las texturas para los mecánicos e ingenieros están en el archivo anim.wad. Los archivos .tex 
para los mecànicos estan localizadas en la carpeta (dentro del anim.wad) 
\animationdata\qualifying\skins y el nombre de estos archivos son: pitcrew_myteam.tex. 

Ahora solo tenemos que modificar estas texturas. Pero para facilitar nuestro trabajo vamos a 
usar una plantilla: Pitcrews templates by MaxDownforce and ChaosF1 de gpxcarpainting. 
Las texturas a modificar son:  

 

Plantilla de mecánicos, archivo: 
pitcrew_myteam.tex  

 

Plantilla de ingenieros, archivo: 
engin_myteam.tex  
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Pintando el fondo de estas plantillas y añadiendo algunos logos de nuestro coche tenemos 
unos bonitos mecánicos e ingenieros para nuestro equipo de F1:  

 

Plantilla de mecánicos, archivo: 
pitcrew_myteam.tex  

 

Plantilla de ingenieros, archivo: 
engin_myteam.tex  

 

Para finalizar nuestro trabajo, añadir una alpha layer y guardar como tga (256pixels X 
256pixels) (32 bits y RLE encoded (RLE encoded es opcional, pero es mejor porque el archivo 
tiene menor tamaño)): pitcrew.tga y engin.tga. 
Notar que no se tienen que voltear verticalmente las texturas (En esta plantilla en concreto, 
como comentabamos antes en el casco) Hacer una copia de seguredad de tu anim.wad  
Crear los archivos .tex con TexResizer (pitcrew.tex y engin.tex) y actualiza tu anim.wad con 
WadUpdater (Abrir Wadupdater, seleccionar el pitcrew_myteam.tex y el anim.wad. Hacer click 
en UpdateWad y automáticamente el pitcrew_myteam.tex será actualizado en tu anim.wad. 
Hacer lo mismo para el engin_myteam.tex). 
 
Además tienes que usar el nombre original del slot para los archivos: pitcrew_myteam.tex y 
engin_myteam.tex, es decir, si tú equipo está en el slot 11, tienes que usar el nombre de prost 
para myteam. 
Esto es porque con el TeamEditor se puede cambiar el nombre del slot pero esto solo afecta al 
nombre de la carshape (car_myteam_car1_lod0.gp4 ...) y para el nombre del cockpit 
(cp_myteam.tex). Pero no para los cascos (hemlets) y los mecánicos e ingenieros (pitcrew). Por 
tanto tienes que usar los nombres originales de los equipos para los mecánicos e ingenieros y 
los números originales para los cascos.  
 
Los nombres originales de los slots son:  

• ferrari -> slot1  
• mclaren -> slot2  
• williams -> slot3  
• benetton -> slot4  

• bar -> slot5  
• jordan -> slot6  
• arrows -> slot7  
• sauber -> slot8  
• jaguar -> slot9  
• minardi -> slot10  
• prost -> slot11  
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Mecànicos en GP4  

 

 
Mecànicos en GP4  
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Mecànicos en GP4  
 

Ingenieros en GP4  
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Ingenieros en GP4  
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De ZModeler a GP4 
 
Los nombres de los archivos que se necesitan para un coche de GP4 son:  

Car 1 

car_myteam_car1_lod_0.gp4 
car_myteam_car1_lod_1.gp4 
car_myteam_car1_lod_2.gp4 
car_myteam_car1_lod_3.gp4 
car_myteam_car1_lod_4.gp4  

Car 2 

car_myteam_car2_lod_0.gp4 
car_myteam_car2_lod_1.gp4 
car_myteam_car2_lod_2.gp4 
car_myteam_car2_lod_3.gp4 
car_myteam_car2_lod_4.gp4  

 
* Algunos equipos tienen un archivo: car_myteam_car(1 or 2)_lod_35.gp4, si vas a editar uno 
de estos equipos puedes borrar este archivo (no me preguntéis porque). 
 
La diferencia entre estos archivos es que el lod_0 es el más detallado y el lod_4 el menos 
detallado. Es decir se ve el lod_0 cuando el coche está cerca y el lod_4 cuando el coche esta 
muy lejos, como por ejemplo en los retrovisores. 
 
La diferencia entre el car1 y el car2 es el mapeado de los números (recuerda el paso final de la 
sección de mapeado donde habiamos guardado nuestro coche como car1 y car2 y remapeado 
el nº en el car2 en un lugar diferente de la textura con respecto al car1). 
 
Por tanto ahora el proceso a seguir es simple, primero de todo comprueba el orden de los 28 
objetos. Segundo exportar el car1.z3d a car_myteam_car1_lod_0.gp4 y ya tenemos hecho el 
lod_0 para el coche 1. 
Para hacer el lod_1, lod_2 and lod_3, borrar los z-objects del car1.z3d (z_cockpit_insert, 
z_cockpit_left_mirror,z_cockpit_right_mirror, z_cockpit_visor), exportar este archivo como: 
car_myteam_car1_lod_1.gp4, car_myteam_car1_lod_2.gp4, car_myteam_car1_lod_3.gp4. 
 
Repetir el mismo proceso para car2.z3d 
 
Recordar el car_lod_4 que habíamos remapeado. Exportar este archivo como: 
car_myteam_car1_lod_4.gp4 y car_myteam_car2_lod_4.gp4 
 
IMPORTANTE: 
Para exportar el coche tienes que cargar todas las texturas (en el material editor), de esta 
forma verás las texturas sobre el coche en la vista 3D. Si no haces esto, las texturas serán 
exportadas de forma incorrecta. 
 
Yo he usado el nombre de myteam, pero se tiene que usar el del slot al que queramos poner el 
coche:  

• ferrari -> slot1  
• mclaren -> slot2  
• williams -> slot3  
• benetton -> slot4  
• bar -> slot5  
• jordan -> slot6  
• arrows -> slot7  
• sauber -> slot8  
• jaguar -> slot9  
• minardi -> slot10  
• prost -> slot11  
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Además os tengo que decir que podemos cambiar el nombre del slot con TeamEditor, es decir, 
poder usar cualquier nombre para el slot. Por ejemplo podemos cambiar el nombre del slot 11 a 
vicente y entonces nombrar los archivos como: car_vicente_car1_lod_0.gp4, 
car_vicente_car1_lod_1.gp4 ... 
 
La siguiente imagen muestra el TeamEdior. Se pueden cargar todas las carshapes disponibles 
en el cars.wad. Por tanto, solo hay que actualizar nuestro cars.wad con los archivos con el 
nuevo nombre del slot (car_vicente_car1_lod_0.gp4 ... ) y elegir esta carshape en el 
TeamEditor. Muy simple.  

 
 

 
 
 
Ahora ya tenemos todos los archivos (shapes) de nuestro coche para pasar a GP4.  
Recordar que podemos usar nuestro coche para cualquer slot ya que las texturas las hemos 
nombrado como VTE_1.TGA, VTE_2.TGA y VTE_3.TGA o un nombre similar (este nombre 
debe ser diferente de ferrari, maclaren, williams, benetton, bar, jordan, arrows, sauber, jaguar, 
minardi and prost). Entonces nuestro coche va a buscar las texturas llamadas VTE_1.TEX, 
VTE_2.TEX y VTE_3.TEX sin que influya el nombre del slot. 

Ahora necesitamos guardar las texturas del coche en formato tex. Para ello podemos usar gp4-
master (leer el carpainting tutorial by Thijis (a.k.a. Knight)) o bién usar TexResizer 
(www.realgpx.com).  
 
El TexResizer es muy simple de usar, basta con abrir un archivo existente .tex, ajustar la 
anchura y altura a 1024. Entonces hacer click con el botón direcho sobre la imagen grande de 
la textura y seleccionar load from tga. A continuación hacer click en downsample y guardar el 
archivo .tex.  
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Hacer lo mismo para todas las texturas. 
Recordar que el hi_mycar.tex es 1024x1024 y el mycar.tex es 512 x512. 
Además notar que hay que voltear verticalmente las texturas (archivos .tga)y añadirles un canal 
alfa (alpha layer) antes de cargar los tga en TexResizer.  
El resultado de hacer esto en TexResizer es:  

 

Después de esto ya tenemos creados los archivos tex (texturas) para nuestro coche.  

Solo nos falta poner los 10 archivos .gp4 y los .tex en nuestro cars.wad. Para ello podemos 
usar gp4-master (leer el tutorial carpainting tutorial by Thijis (a.k.a. Knight)) o también podemos 
usar WadUpdater (www.realgpx.com).  
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Primero de todo hacer una copia de seguridad de nuestro cars.wad, entonces para instalar 
nuestro coche en nuestro cars.wad: copiar los 10 archivos .gp4 y todos los archivos .tex (los hi_ 
y los demás)en una nueva carpeta llamada por ejemplo mycar.  
A continuación en WadUpdater haz click en el botón de Select a Folder (seleccionar una 
carpeta) y también selecciona tu cars.wad de la carpeta GP4 (es decir donde tengas instalado 
GP4) y finalmente haz click en el botón Update wad. 
Tu cars.wad será actualizado en pocos segundos.  

 

Finalmente podemos ajustar la posición del volante y del casco y cambiar el color de los 
brazos del piloto (rims color). Para ello vamos a usar TeamEditor (se puede descargar en 
www.realgpx.com) 
 
Para hacer estos cambios solo tenemos que iniciar TeamEditor y cambiar las coordenadas del 
casco y del volante para que en la vista 3D de TeamEditor estén en la posición correcta.  
Para cambiar el color de los brazos, hacer doble click sobre la caja de color del brazo y cambiar 
el color. 
Además podemos cambiar la marca de los neumáticos (michelín o bridgestone) con este 
programa. 
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Cambiar la potencia del coche, las revoluciones máximas, la masa, la 
carga aerodinámica...  
 
Para finalizar nuestro coche tenemos que cambiar algunos parámetros físicos de nuestro coche 
con Physics Editor v1.03 de Aubrey Windle. 
Se puede descargar de www.grandprixgames.org o cualquier gp4 website. 
 
Las siguientes imágenes son auto explicativas y muestran todo lo que se puede modificar de 
nuestro coche:  
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Mi consejo para usar el GP4 Physics Editor v1.03 es: descomprimir el gp4phys.zip en una 
carpeta llamada gp4phys, entonces copiar el GP4.exe de tu carpeta principal de GP4 (notar 
que el GP4 Physics Editor v1.03 solo funciona con la versión desencriptada v1.02 del gp4.exe 
(decrypted v1.02 version of gp4.exe) que está disponible en varios sitios web, el gp4.exe vi1.02 
es la versión del official patch 9.6). 
 
Ahora ejecuta el GP4Phys.exe y aparecerá el GP4 Physics Editor v1.03. Entonces ya puedes 
hacer algunos cambios a los valores de los parámetros que aparecen aquí. (Hay una buena 
explicación de cada parámetro en la ayuda del GP4 Physics Editor). 
Lo mejor es cambiar el Human Race Power, Human Qualy Power y las Max RPM, el resultado 
será un coche más rápido, si hemos aumentado la potencia y las RPM. 
 
Finalmente guardar está información en un archivo .gp3 que se puede cargar en GPxPatch, por 
ejemplo mycar.gp3. Ahora ir a la carpeta GP4/gpxdata/ y copiar este archivo, entonces iniciar 
GPxPatch e ir a GPxPatch -> GPxSet y cargar nuestro GP4/gpxdata/mycar.gp3 y ya tenemos 
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instaladas las modificaciones de la física de nuestro coche. Ahora solo nos queda iniciar 
GPxPatch y conducir con nuestro coche con la nueva física que hemos modificado, además 
veremos que nuestro coche es más rápido (si hemos aumentado la potencia del motor y/o las 
revoluciones), es decir los tiempos por vuelta van a disminuir. 
Por cierto, también podemos editar directamente nuestro GP4/gp4.exe si no queremos usar 
GPxPatch, pero yo prefiero no editar el GP4/gp4.exe para evitar problemas. 
 

 

 
 

Además se pueden cambiar algunos parámetros de nuestro coche con TeamEditor. 
Las siguientes imágenes muestran que se puede cambiar la marca del neumático, el nombre 
del equipo y del motor, la potencia del motor, el % de rotura mecánica y las marchas.  
Hay que destacar que si cambiamos la potencia del coche con Team Editor solo va a afectar a 
la "performance" de los coches y tu coche no será más rápido y no vas a mejorar tus tiempos 
por vuelta. 
 
Y en la sección de pilotos además de cambiar el nombre de los pilotos podemos cambiar la 
"performance" de los pilotos. 
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Felicidades, ya tienes acabado tu coche para GP4.  
Ahora solo queda dar vueltas a nuestros circuitos favoritos con el. 

Algunas imágenes de mis coches para gp4 son:  
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Resumen 
 
Los pasos esenciales para modificar el coche son:  

• Importar el lod_0 del coche original de gp4 y guardar como car1.z3d 
>Importar el lod_4 del coche original de gp4 y guardar como car_lod_4.z3d 

• Modificar el coche usando fotos como referencia. Calcular los normales. 
• Dividir el coche en los diferentes objetos que necesita un coche de gp4 (ver la lista) y 

ordenarlos por orden alfabético (el orden de la lista). 
• Mapear el coche (recordar mapear el lod_4), y cambiar el nombre de los materiales a 

un nombre diferente (diferente de los nombres originales de los equipos de gp4). 
• Pintar el coche. 
• Crear los archivos .tex 
• Hacer las shapes para gp4 exportándolas con ZModeler (recordar cargar todas las 

texturas antes de exporta el coche). 
• Actualizar el cars.wad con gp4-master o WadUpdater. 
• Cambiar la posición del casco y del volante además del color de los brazos con 

TeamEditor. Modificar la fisica del coche con GP4 Phisics Editor. 
• Ya tenemos acabado nuestro coche. 
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Links y tutorials 
 

Tutoriales Útiles  
• Carpainting guide by Thijis (a.k.a. Knight)  
• Quick Guide to find out Mapping GP4 by Raymond (a.k.a. Max 

Downforce)  
• ZModeler full documentation  
• ZModeler: creating cars from scratch  
• All the tutorials in gpxcarpainting  

 
Links  

• gpxcarpainting  (http://racing-leagues.com/gpxcarpainting/) 
• ZModeler official site (http://www.zmodeler2.com/) 
• www.grandprixgames.org (http://www.grandprixgames.org/) 
• realgpx (http://www.realgpx.org/) 
• Gp4 tracks by Ricardo Lampert 

(http://ricardolampert.drivingitalia.net/) 
• GPxPatch (http://www.xs4all.nl/~rsdi/) 
• www.f1games.it (http://www.f1games.it) 
• www.gp4spain.com (http://www.gp4spain.com) 
• ZModeler plug-ins (http://pedro2.spytech.cz/zmodeler) 
• Logos (http://www.brandsoftheworld.com/) 
• f1-racing (http://f1.racing-live.com/) 
• f1total (http://www.f1total.com/) 
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Cambios en el tutorial 
 

 
ChangeLog  

 v1.0 (4/1/2005)  

First release of the tutorial. 
The origin of the tutorial was the result of some post on 
gpxcarpainting forum about mapping and adjust the normals.  

 v1.1 (30/3/2005)  

Added a ZModeler quick guide that explains all that you should 
know about it to build a gp4 car. 
Added a section that explains how to buid the mesh of the car. 
Mapping and normals sections are improved. 
Added some new sections: paint the car, get car in game, summary 
and the most useful links.  

 v1.2 (30/6/2005)  

Added a tip that explains how to order objects by alphabetical order 
usen 3Deditor. 
Improved paint the car section with an example of the movistar F1 
car. 
Improved get car in game section with explanations about how to 
use TexResizer, WadUpdater and TeamEditor. 
Added more links. 
Added Acknowledgment section  

 v1.3 (20/8/2005)  

Finally the tutorial have been trasnlated to Spanish. Added an 
explanation about how to paint cockpit, helmets and pitcrews with 
some examples and lots of photos. 
Some explanations about Texture shading, Car body lines and 
screws. And some examples with lots of photos. 
Added an explanation about how to change the cars power with gp4 
physics editor. 
Added an explanation about how to get car in-out game with 
WadUpdater. 
Improved the Mapping section: improve the explanations about my 
mapping method and added an explanation about how to map the 
car (an explanation for begginers). Added some mapping tips: 
mapping continous surfaces of the car, mapping carbone fibre 
surfaces (thanks to Bojan Tarticchio to tell this method to us) Added 
some tips about the car_lod_4: map this car to see the correct 
colors.  
Corrected some grammar mistakes on the tutorial. And improved 
some explanations in all the tutorial. 
Added a table of ZModeler hot-keys and an explanation about how 
set up hotkeys in the ZModeler section.  
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